Cc0002 INTERFACE BARRES D'OUTILS
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Fenétre > Préférences,
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2- Les barres d'outils :

Affichage — Barres d'outils :
+ Styles
*  Mesures
+ Sections
- Standard
« Vues, etc...
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Icone Légende (Raccourci) Utilisation

2.1- Standard

Nouveau (Ctrl + N) Fichier

Ouvrir (Ctrl + O) Fichier

Enregistrer (Ctrl + S) Fichier

¢ < O ¥ &

Couper (Maj + Modifier
Supprimer)
Copier (Ctrl + C) Modifier
Coller (Ctrl + V) Modifier
® Effacer (Supprimer) Modifier
9 Annuler (Alt + Retour +  Modifier
Arriére )
Q Rétablir (Ctrl +Y) Modifier
g Imprimer (Ctrl + P) Fichier
? Infos sur le modéle Fenétre
2.2- Principaux
IT Sélectionner (Espace)  Outils Sélectionner un objet ou une forme.
- La sélection de droite vers la gauche permet de
sélectionner tous les objets qui touchent le cadre de
sélection (contour du cadre en pointiller).
- La sélection de gauche vers |la droite permet de
sélectionner tous les objets qui sont a l'intérieur du
cadre de sélection (contour du cadre plein).
- Pour sélectionnez l'intégralité des éléments d'une
face, faire double cliqgue gauche sur la face en
question du modeéle.
© Créer un composant (G) Transformer une sélection (d'une ou plusieurs

formes) en 1 objet unique. (Grouper)
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Icone

Légende (Raccourci)

@ Colorier (B)

g

Effacer (E)

Menu

Quitils

Quitils

Utilisation

Appliquer une couleur ou une texture a l'ensemble
d'une face (fermée) d'un objet.

Effacer les segments, les formes, les objets ...

@ ° @ =’ \

S

2.4-

& Pousser/Tirer (P)

¥R

<

i
s
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Ligne (L)

Rectangle (R)

Cercle (C)

Arc (A)

Polygone

Main levée

Modification

Déplacer (M)

Faire pivoter (Q)

Décalage (F)

Echelle (S)

Suivez-moi

Dessiner

Dessiner

Dessiner

Dessiner

Dessiner

Dessiner

Ouitils

Outils

Ouitils

Outils

Outils

Ouitils

Dessiner une forme libre (en plan) avec des
morceaux de droites.

Dessiner une forme plane carré ou rectangulaire.

Dessiner un cercle plan.

Dessiner un arc de cercle plan.

Dessiner un forme polygonale. Saisir le nombre de
faces souhaiter.

Ensuite, cliquer pour déterminer le centre du
polygone et enfin saisir la dimension du rayon.

Dessiner une forme a main levée. Le logiciel
l'interprétera comme une série de ligne droite.

Donner de I'épaisseur aux formes planes. (agrandir
ou réduire les volumes).

Déplacer un objet (2D) ou une face d'un objet (3D).
Exemple : soulever un toit de maison en tirant sur
l'aréte centrale !!

Faire une rotation d'une forme suivant les axes.

1- Cliquer pour déterminer le centre de la rotation

2- Cliquer pour choisir le plan de rotation (X, Y ou Z)
3- Déterminer a la souris I'angle de rotation

Agrandir ou réduire une forme.

Agrandir ou réduire une forme, tout en conservant les
points d'ancrages.

Extraire une forme en 3D . Il faut avoir dessiner un
axe a faire suivre au plan sélectionneé.

1- Dessiner |la forme et |le guide

2- Sélectionner l'outil puis cliquer sur la face
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Icone Légende (Raccourci) Menu Utilisation

3- Suivre le guide
4- Valider avec « Entrée »

%‘ Afficher les plans de Outils

section
& Afficher les coupes Outils
.@ Plan de section Outils

2.6- Caméra

$ Orbite (O) Caméra Changer d'angle de vue.

/2 Panoramique (H) Caméra Déplacer la vue.

’@ Zoom (Z) Caméra  Zoomer (Ctrl + Roulette de la souris)

:O: Zoom étendu Caméra La fenétre s'adapte a la taille du dessin.

Fenétre de zoom Caméra  Effectue un zoom avec la caméra pour afficher ce qui
se trouve dans la fenétre de sélection.

q Précédent Caméra  Récupérer la vue du zoom précédent.

2.7- Styles
@ Transparence Affichage Activer ou désactiver la transparence des textures.
> Style de
face
Filaire Affichage Afficher toutes les arétes des formes.
@ > Style de
face
@ Ligne cachée Affichage Afficher uniquement les arétes visibles des formes.
> Style de
face
Ombré Affichage Afficher les faces des objets.
@ > Style de
face
@‘ Ombre avec textures Affichage Affiche les textures et les ombres des objets.
> Style de
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Icone Légende (Raccourci) Menu Utilisation

face

|@ Monochrome Affichage Afficher en noir et blanc les objets
> Style de
face

0 Arétes arrieres Affichage Afficher toutes les arétes des formes. Les cachées
> Style de sont en pointillées.
face

2.8- Construction

“@ Meétre (T) Outils Mesurer des distances.
g\ Cotation Quitils Coter le dessin.
@ Rapporteur Outils Mesurer des angles.

1- Cliquer pour déterminer I'angle a mesurer et dans
quel plan faire la mesure,

2- Cliquer pour donner la premiere direction et
ensuite (sans cliquer) viser la deuxiéme direction.
Lire la valeur dans la barre de mesure.

Texte Outils Annoter le dessin.
;< Axes Outils Modifier le repére d'origine.
‘ Texte 3D Outils

2.9- Visite

@ Plan de section Outils Créer un plan de section.
Déterminer l'axe du plan, ensuite le déplacer a
I'endroit ou on souhaite sectionner. Toutes les formes
au dela du plan de section seront supprimées.

,Q Positionner la caméra Caméra
" Visite Caméra

Pivoter Caméra

(S
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Icone Légende (Raccourci) Menu Utilisation

2.10- Ombres
Q Afficher / Masquer les Affichage
ombres

9 Paramétres d'ombre

2.11- Solides
552 Enveloppe externe Outils

2.12- Affichages

@ Isométrique Cameéra >
Vues
standard

Dessus Cameéra >
Vues
standard

Face Caméra >
Vues
standard

Droite Caméra >
Vues
standard

Arriere Caméra >
Vues
standard

Gauche Cameéra >
ﬂ Vues
standard

o B &5 @

2.13- Google et Entrep6t

Ajouter un emplacement Fichier

=y
‘1 |

Activer / désactiver le Fichier
relief

photographiques

Afficher un apergu du Fichier
modele dans Google
Earth

©
Textures Fichier

&

e
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Icone Légende (Raccourci) Menu Utilisation

@ Télécharger des Fichier
modeles
@ Partager le modéle Fichier

a Partager le composant  Fichier

© Prolongement de la Fenétre  Ajouter des prolongements de plugin a Sketchup.
banque d'image

2.14- Mesures

Cette barre permet de saisir des valeurs (en métre par défaut). Il
n'y a pas besoin de cliquer dans la barre avant de débuter la
saisie des distances. Pour les formes avec plusieurs valeurs
(rectangle par exemple), saisir les valeurs séparées par des ; .

Mesures |

2.15- Calques

Voir les explications dans le tableau « Fenétres ».

3- Les fenétres
* L'instructeur r’
* Les calques ®
* Les composants e e |

+ Lesstyles

* Les matiéres
Les fenétres peuvent étre empilées et réduites en cliquant
dans la barre de titre (barre bleue).

3.1- Instructeur 3.2- Calques 3.3- Composants

s @O B LA &
= |veble | co.. | ®|
& Layerd B \
Sélectionner |Mudﬁsr] Statistiques |
Ev o 20
' Barre-aimature_acier ‘_:I
v
Outil Sélectionner ?H Charpente_bois
oalectionner des entites a
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Une aide précieuse !

Tres utile pour « décalquer » un Permet

plan scanné par exemple.

+ permet d'ajouter un calque
- permet de le supprimer
Attention, on ne peut
modifier I'ordre des calques.
La case a cocher « visible »
permet d'activer/désactiver un
calque.

des
la

de rechercher
composants dans
bibliotheque de sketchup.
http://sketchup.google.com/3dw

pas arehouse/

3.4- Styles

Styles B3
| Style simple a
Couleurs par défaut. Style de @
face Ombré avec textures, Ciel
ackivé. Arriére-plan vert. s
Sélectionner I Modifier | Mélange |
a2

4: $ Q ISters par défaut
o
w |l

Ihf?[] U

@%0E

styles X
| Style simple
Couleurs par défaut. Style de @
face Ombré avec textures, Ciel
activé, Arrigre-plan vert. (s}

Sélectionner  Modifier | Mélange |

BOoOL®

IV frétes

[™ Arétes arrigre

[ Prefiles I__
™ Profondeur l_
I Prolongées I_
[ Extrémicés I_
I Floues

Aréte

Couleur & |‘I‘owesidentiques v| .

Permet d'éditer les styles utilisés dans le document.

Styles X
| Style simple 9
Couleurs par défaut, Style de @
Face Ombré avec textures, Ciel
ackive, Arriere-plan vert, s

Sélectionner | Modffier Mélange |

Pour mélanger des parametres du style
actuel, prélevez-les dans le panneau du bas
et appliquez-les aux catégoties souhaitées.

D

0 Paramétres de face

Paramétres d'aréte

O’ Paramétres d'arriére-plan
@ Paramétres de filigrane

.Paramétres de modélisation

3.5- Matiéres
Matiéres X
|[Par défaut [ <Beige>1 id

a
&

4

Sélectionner I Modifier [

c:l I.Jl) P} I'ul'égétatinn

Sélectionner  Modifier I

Couleur

MNuancier : m |:] ‘ “

i

TEHtI.II‘E

Er

[ Utiliser lmage de texture

| _
: lg I Colorier
t o ) U [ | Réinitialiser
la couleur
Dpacité
J I {100 -

Sélectionner des matiéres
(Végétation, bois, toiture, etc...)
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Modifier des matiéres (couleurs,

opacité, texture, etc...)

La pipette permet de prélever
une matiére dans le dessin.
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4- Les plugins

Les plugins sont des scripts écrits en Ruby qui permettent d'étendre les fonctionnalités du logiciel.
On les appelle aussi extensions dans le menu « Fenétre > Préférences > Extensions ».

Certains sont intégrés comme le bac a sable. D'autres sont disponibles en téléchargement ici :

http://www.sketchup.com/intl/en/download/plugins.html.

Icone Légende (Raccourci) Utilisation

4.1- Projection

Présentation de 'extension :
http:/lwww .arch-image.com/wordpress/2010/06/07/plugin-sketchup-projections-v2/.

(/ Effacer les guides Supprimer les guides (lignes et points)
> Insérer un point guide Créer simplement un point guide la ou on clique.
. Insérer des guides Créer des guides soit sur la ligne que vous cliquez, soit sur
o passant par des lignes  toutes les arétes des faces que vous cliquez. Un affichage
ou des faces temporaire montre ce qui va étre créé si vous cliquez
s Insérer un guide Créer un guide perpendiculaire a la face ou se trouve le curseur.

perpendiculaire a la face
passant par un point

o Insérer des guides aux
= intersections entre les
faces sélectionnées

Sélectionner les faces puis cliquer sur
l'icone.

i1, Inserer des guides a Créer des guides paralléles suivant un intervalle régulier spécifié.
o intervalles réguliers a 1- Se déplace sur une aréte et cliquer.
partir d'une ligne 2- Déplacer le pointeur sur une seconde aréte, face ou tout autre

emplacement, et cliquer. Des guides paralléles sont créés, la
distance entre eux étant la distance saisie dans la boite de
dialogue « Mesures ».

Le premier intervalle entre guide est compté a partir de la
premiere aréte cliquée.

3- Lorsque les guides sont créés, appuyer sur la touche
« Entrée » pour choisir une autre aréte de départ, ou entrer une
nouvelle distance.

Insérer des guides Créer des guides a intervalle régulier entre les points que cliquer.
divisant réguliérement 1- Déplacer le curseur sur une aréte et cliquer.
une ligne 2- Saisir le nombre de divisions souhaitées

3- Déplacer le curseur sur une seconde aréte, face ou tout autre
emplacement, et cliquer. Des guides paralléles sont créés.

>4 Insérer des guides Créer des guides radiaux suivant un angle régulier.

""" radiaux autour d'un point 1- Sélectionner une aréte ou un guide, ou cliquer n'importe ou
sur une face : ce point sera le point d'origine du réseau polaire
de guides.

2- Saisir un angle dans la boite de dialogue « Mesures » ou
deplacer le curseur dans le sens des aiguilles d'une montre ou le
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Icone Légende (Raccourci) Utilisation

sens inverse par rapport au point d’origine.
3- Cliquer pour créer les guides.

Insérer des guides au Créer des guides le long des bords d’un rectangle.

..é....é..
B

bord d'un rectangle Le ratio entre la largeur et la hauteur du rectangle est de 1,618
par défaut. (régle d'or)
1 Projeter un point guide 1- Sélectionner le point guide et cliquez I'icéne.

~—  perpendiculairement a
une guide, une ligne ou
a une face

2- Déplacer le curseur sur un guide, une aréte ou
une face pour voir la projection, puis cliquer.

3- Choisir si vous souhaitez créer un guide fini, un
guide infini ou une ligne normale entre le point
guide et sa projection.

11 Projeter lignes/guides Ajouter des points guides a chaque intersection entre chaque

sous forme de points sur ligne et chaque face de la sélection.

des faces Sélectionner le(s) ligne(s) ou le(s) guide(s) et le(s) face(s) puis
cliquer sur l'icéne.

Avant Aprés
—  Projeter des lignes 1- Sélectionner les lignes et cliquer I'icéne.
~—  perpendiculairement au 2- Déplacer le curseur sur les faces pour voir la projection et
plan d'une face cliquer.

3- Choisir si vous voulez créer des faces entre les lignes et leurs
projections ou pas .

Créer des faces: |Non v
o

1- Sélectionner les faces et cliquer
I'icone.

2- Déplacer le curseur sur les faces
pour voir la prévisualisation de la
projection (lignes pointillées vertes et
_ roses), puis cliquer.

<  Projeter des faces
~—  perpendiculairement aux
plans des faces

3- Choisir si vous souhaitez créer les faces entre les faces et
leurs projections ou pas.

Projeter des faces surle 1- Sélectionner la ou les faces et cliquer I'icéne.
plan d'une face, le long  2- Cliquer les deux points qui définissent le vecteur, c'est-a-dire
d'un vecteur la direction de projection.
3- Déplacer le curseur sur les faces pour prévisualiser la
projection (lignes pointillées vertes et roses), puis cliquer.
4- Choisir si vous souhaitez créer des faces entre les faces et
leurs projections ou pas.

=0
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Icone Légende (Raccourci) Utilisation

.5 Pousser/Tirer le long Extruder une face par pousser-tirer le long d’un vecteur. Cet outil
d'un vecteur peut étre utilisé avec ou sans sélection .

» Lorsque des faces sont sélectionnées
1- Cliquer les deux points qui définissent le vecteur, c'est-a-
dire la direction du pousser-tirer.
2- Déplacer le curseur sur les faces pour visualiser la
prévisualisation de projection (lignes pointillées vertes et roses),
puis cliquer.

« Lorsque rien n’est sélectionné
1- Cliquer les deux points qui définissent le vecteur, et déplacer
le curseur sur les faces. La prévisualisation montre ce que le
resultat va donner
2- Cliquer pour pousser-tirer.

& Pousser/Tirer le long de Extruder une face ou une sélection de faces par pousser-tirer le
la perpendiculaire a la long de leur(s) perpendiculaires(s). |l peut étre utilisé avec ou
face sans sélection.

» Lorsque des faces sont sélectionnées
1- Cliquer sur l'icone.
2- Vérifier la boite de dialogue « Mesures » pour la distance a
pousser-tirer (1 metre par défaut), et saisir une nouvelle distance
Si nécessaire.
3- Cliquer n’importe ou sur I'’écran pour pousser-tirer la sélection.
Lorsque vous avez terminé, vous pouvez cliquer d’autres faces
pour les pousser-tirer sur la méme distance.

» Lorsque rien n’est sélectionné
1- Déplacer le curseur sur les faces, cliquer pour pousser-
tirer. Lorsque vous avez terminé, vous étes prét a cliquer
d’autres faces pour les pousser-tirer sur la méme distance.
Une nouvelle distance peut étre tapée dans la boite de dialogue
Mesures a tout moment.

~—  Extruder des lignes en  Extruder une ligne ou une sélection de lignes (ou courbes,
faces, le long d'un cercles, arcs) le long d’'un vecteur.
vecteur 1- Sélectionner la ou les lignes et cliquer I'icéne.
2- Cliquer les deux points pour définir la direction et la distance
d’extrusion. Lorsque le premier point est cliqué, vérifier la boite
de dialogue « Mesures » pour voir la valeur d’extrusion.
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Icone Légende (Raccourci) Utilisation

4.2- Fredo Scale

Présentation de l'extension :
http://www.arch-image.com/wordpress/2010/04/06/plugin-sketchup-fredoscale/.

Outils > Fredo6 Collection > FredoScale

Passer I'extension en frangais dans les préférences de langues

Nécessite la librairie Fredo6 : http://www.systemed.fr/forum-bricolage/librairie-libfredo6-3-7c-03-juin-
2011-t43119.html

Mise a l'échelle avec
orientation de la boite

’ | Effilement avec
orientation de la boite.

j‘t ! Cisaillement Planaire
© avec orientation de la
boite

it Cisaillement Planaire par
‘ sélection d'un plan ou
d'un angle

[\, Etirement avec
orientation de la boite

B Torsion avec orientation
de la boite

r, Rotation avec orientation
de la boite

ﬂF, Rotation par sélection
d'un plan ou d'un angle

r Courbure radiale par

sélection d'un plan ou
d'un angle.

Icone Légende (Raccourci)  Utilisation

4.3- Toggle Units

Présentation de l'extension :
http://www.arch-image.com/wordpress/2011/02/23/plugin-sketchup-changez-unite/.
Affichage > Barres d'outils > Toggle Units

Plugins > Changement d'unités
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Légende (Raccourci)

Unité de dessin >
Décimale

Unité de dessin >
Architecturale

Unité de dessin >
Fractionnelle

Unité de dessin >
Ingénierie

Unité de dessin > Pouce

Unité de dessin > Pieds
Unité de dessin >
Millimétre

Unité de dessin >
Centimeétre

Unité de dessin > Métre
Diminuer la précision
(nombre de décimales)

Augmenter la précision
(nombre de décimales)

Afficher le format

Utilisation
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co0o0o=3 Les Outils de Navigation

outils

Cet outil $ vous sert a visualiser votre dessin sous tous ses angles.

Cet outil /? sert a déplacer le dessin sur I'écran

Ces 2 outils ’® "@3 servent a agrandir ou rétrécir, la fenétre zoom vous permet d’agrandir sur la
fenétre que vous déterminez

L
Les 2 autres zooms “* K Zoom Etendu visualise le dessin en entier, zoom précédent ...

Q Positionner la caméra

@'Pivoter la caméra
L 14

Visiter en continu

'@Plan de Section

17 1 (0003_sketchup_outilsNavigation
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OUTIL SELECTION

RECTANGLE DE SELECTION

L’outil Sélectionner permet de dessiner et
d’étirer un rectangle afin

d’englober les entités a sélectionner.

Il existe deux fagons d’utiliser cet outil sui-

vant ce que vous désirez

sélectionner : A,
Sélectionnez 'outil Sélectionner, votre cur- -
seur se transforme en

fl éche,

- Eloignez le curseur de votre souris en
haut a gauche de I'entités a sélectionner,
- Cliquez et maintenez enfoncé le bouton gauche de votre souris puis déplacez le curseur en bas
a droite afi n d’englober dans le rectangle continu les entités a sélectionn.

le rectangle de sélection continu disparait,
toutes les entités entierement incluses
dans ce Relachez le bouton gauche de
votre souris, dans ce rectangle sont sélec-
tionnées et apparaissent en bleu

Pour selectionner toutes les arétes,sans
pour cela les toucher, choisir le rectangle
de sélection en pointillé, cliquez, maintenez
enfoncé

La touche CTRL vous permet d’ajouter un
élément a votre sélection

La touche MAJ vous permet d’ajouter ou supprimer un élément a la sélection

« Un simple clic vous permet de selectionner une aréte

« Un double clic selectionne les arétes ou faces adjacentes,

« Un triple-clic sélectionne toutes les entités connectées a I'aréte ou la
« face sélectionnée

Menu contextuel (clic droit)

Sélectionnez I'outil Sélectionner, votre curseur se transforme en fl éche,
Un clic droit sur une entité vous ouvre le menu contextuel de celle-ci,
choisissez Sélectionner :

- Arétes englobantes : Toutes les arétes englobant une face seront sé-
lectionnées (cela revient a faire un double-clic).

- Faces connectées : Toutes les faces adjacentes seront sélectionnées.
- Tous les éléments connectés : Toutes les arétes et faces englobantes
seront sélectionnées (cela revient a faire un triple-clic).

- Tous les éléments du méme calque : Sélectionne toutes les entités sur
le méme calque que I'entité sélectionnée.

- Tous les éléments de méme matiére : Sélectionne toutes les entités de
méme matiére que l'entité sélectionnée

Sélectionnez I'outil Sélectionner, votre curseur se transforme en fl éche,
1 2 C0004_sketchup_selections



- Eloignez le curseur de votre souris en bas a droite de I'entités a sélectionner,

- Cliquez et maintenez enfoncé le bouton gauche de votre souris puis déplacez le curseur en haut
a gauche afi n d’englober dans le rectangle pointillé les entités a sélectionner,

- Relachez le bouton gauche de votre souris, le rectangle de sélection pointillé disparatit, toutes les
entités partiellement incluses dans ce rectangle sont sélectionnées et apparaissent en bleu.

Pour déselectionner tout, cliquez dans un espace vide de votre fenétre.

La sélection en rectangle pointillé permet de sélectionner des entités diffi ciles d’accés et réduit les
manipulations.

Attention : Le rectangle de sélection continu ou pointillé sélectionne également les entités cachées
par les éléments de premier plan.

AJOUTER/RETIRER A LA SELECTION

Pour opérer des sélections/désélections successives, il existe trois méthodes :

Ajouter/retirer a la sélection :

Sélectionnez I'outil Sélectionner, votre curseur se transforme en fl éche, La touche MAJ mainte-
nue enfoncé avant chaque sélection vous permet d’ajouter ou de retirer une entité a votre sélec-
tion actuelle.

Le curseur de votre souris ( ) vous indique que vous étes en mode Ajouter/Retirer de la sélection.
Ajouter a la sélection :

Sélectionnez I'outil Sélectionner, votre curseur se transforme en fl éche, La touche CTRL (sous
Windows) ou ALT (sous Mac) maintenue enfoncé avant chaque sélection vous permet d’ajouter
une entité a votre sélection actuelle.

Le curseur de votre souris ( ) vous indique que vous étes en mode Ajouter a la sélection.

Retirer a la sélection :

Sélectionnez I'outil Sélectionner, votre curseur se transforme en fléche, la touche MAJ + CTRL
(sous Windows) ou MAJ + ALT (sous Mac) maintenues enfoncés avant chaque sélection vous
permet de retirer une entité a votre sélection actuelle.

Le curseur de votre souris ( ) vous indique que vous étes en mode Retirer a la sélection.

SELECTIONS ADJACENTES

Pour faciliter les sélections adjacentes, SketchUp vous propose deux méthodes :

Clic, double-clic, triple-clic :

Sélectionnez I'outil Sélectionner, votre curseur se transforme en fl €che, Un simple clic sélectionne
une aréte ou une face, un double-clic sélectionne les arétes ou faces adjacentes, un triple-clic
sélectionne toutes les entités connectées a I'aréte ou la face sélectionnée.

Menu contextuel (clic droit) :

Sélectionnez I'outil Sélectionner, votre curseur se transforme en fl éche, Un clic droit sur une entité
vous ouvre le menu contextuel de celle-ci, choisissez Sélectionner :

- Arétes englobantes : Toutes les arétes englobant une face seront sélectionnées (cela revient a
faire un double-clic).

- Faces connectées : Toutes les faces adjacentes seront sélectionnées.

- Tous les éléments connectés : Toutes les arétes et faces englobantes seront sélectionnées (cela
revient a faire un triple-clic).

- Tous les éléments du méme calque : Sélectionne toutes les entités sur le méme calque que I'en-
tité sélectionnée.

- Tous les éléments de méme matiére : Sélectionne toutes les entités de méme matiére que I'enti-
té sélectionnée.

Voir photo ci contre, si 2 volumes sont reliés comme ici avec des lignes, si
I'on fait Ctrl / Clic ou triple clic, tous les objets sont selectionnés
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cCOo0o0s Ovultils de Camera

Outil ORBITE

L’outil Orbite permet de tourner autour de I'objet pour modifier votre point de vue.
Raccourci clavier : O

Sélectionnez 'outil Orbite $ soit depuis la barre d’outils soit depuis le menu Caméra, cliquez et
maintenez le bouton gauche enfoncé tout en vous déplagant dans la vue, la rotation s’eff ectue par
rapport au centre de votre vue.

Astuce : Maintenez le bouton du milieu de la souris (la molette) enfoncé pour obtenir temporaire-
ment 'outil Orbite et ce quel que soit I'outil sélectionné.

Cette fonction est trés utile car 'on a souvent besoin de tourner le modéle sans quitter son outil.

OuUTIL PANORAMIQUE
L’outil Panoramique permet de déplacer la vue horizontalement et verticalement.
Raccourci clavier : H

Sélectionnez 'outil Panoramique /? , Soit via la barre d’outils soit via le menu Caméra, votre
curseur se transforme en main.

Cliquez et maintenez le bouton gauche enfoncé tout en déplagant la souris.

Astuce : La molette de votre souris est également un bouton, quelque soit I'outil sélectionné, main-
tenir enfoncé la molette et la touche MAJ revient a utiliser temporairement I'outil Panoramique.
Maintenir enfoncé le bouton gauche et le bouton du milieu de votre souris reviens également a
utiliser temporairement I'outil Panoramique.

L’avantage de cette méthode a la souris est que vous ne quittez pas votre outil précédent et vous
permet de continuer a dessiner.

OouUTIL Z00M

L’outil Zoom ’©permet de se rapprocher ou de s’éloigner du modéle.

Raccourci clavier : Z

Sélectionnez I'outil Zoom soit via la barre d’outils, soit via le menu Caméra puis cliquez et mainte-
nez le bouton gauche enfoncé tout en vous déplagant verticalement dans la vue.

L'outil Zoom Fenétreid=i vous permet d’effectuer une fenetre d’un détail 8 zoomer

LONGUEUR FOCALE

La longueur focale peut se résumer au zoom, mais pas uniquement.

Une focale grand angle (18mm) équivaut a un zoom arriére en donnant plus de profondeur a la
scéne mais la déforme également contrairement a une focale « téléobjectif » (250mm) qui corres-
pond a un zoom avant en réduisant la profondeur et en « écrasant » I'image.

Pour modifi er la focale de I'image, sélectionnez I'outil Zoom, entrez la valeur de la focale au
clavier (ex: 50mm) et validez par la touche Entrée. Utilisez une profondeur de champ de 50mm
équivaut a la vision humaine.

Cette fonction va vous permettre de tricher pour avoir une vision plus large a I'intérieur d’un bati-
ment en utilisant des valeurs de focale inférieures a 50mm.

Un méme objet photographié a travers diverses focales depuis un méme point (le photographe ne
se déplace pas) :

Focale 28mm Focale 50mm Focale 70mm Focale 210mm visualisation.
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OUTIL ZOOM ETeNDU

w o
L'outil Zoom étendu = permet de recentrer une sélection ou la totalité des objets de la scene
dans la fenétre 3D.

Raccourci clavier : MAJ (ou SHIFT) + Z

RECENTRER LA SCENE

Pour recentrer la totalité des objets de la scene dans la vue 3D, cliquez sur I'outil Zoom étendu.
RECENTRER UNE SELECTION

1- Sélectionnez le(s) objet(s) a recentrer avec I'outil Sélectionner ,

2- faites un clic droit sur le(s) objet(s) sélectionnés,

3- choisissez Zoom étendu dans la fenétre fl ottante.

Un bug d’affi che génant coupe parfois les objets de votre scéne, notamment lorsque vous travail-
lez avec des objets de taille extrémes. Pour rétablir I'affi chage, cliquez une fois sur I'outil Zoom
étendu.

OUTIL PRECEDENT

L’outil Précédent Q permet de revenir successivement aux vue antérieure de votre scéne.
Cet historique d’annulation ne reviendra que sur les actions faites avec les outils :
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C0005 LES OUTILS NAVIGATION

outils

Cet outil $ vous sert a visualiser votre dessin sous tous ses angles.

Cet outil /? sert a déplacer le dessin sur I'écran

Ces 2 outils ’® "@3 servent a agrandir ou rétrécir, la fenétre zoom vous permet d’agrandir sur la
fenétre que vous déterminez

L]
Les 2 autres zooms AR Zoom Etendu visualise le dessin en entier, zoom précédent ...

Q Positionner la caméra

@'Pivoter la caméra
L 14

Visiter en continu

'@Plan de Section
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CO006 OUTILS DE DESSIN
.m Outil Crayon

. S‘) Vous pouvez tracer des lignes en cliquant simple-
ment sur votre dessin, vous remarquerez que Si

O 6’ vous ne sortez pas de I'outil (sans faire echapp)
vous n’avez pas besoin de cliquer sur les deux

E 7 points, le point suivant suffit, cela s’appelle une
polyligne

Traoces précis -

Pour avoir un tracé précis, vous donnez une valeur et vous
cliquez ensuite. La valeur s’affiche en bas a gauche de votre
écran

Lorsque qu’un point de la polyligne rejoint le premier point, elle

provoque une suface fermée et se teinte en gris

On peut tracer des lignes a l'intérieur de la surface existante
Utiliser les points d’inférence pour s’accrocher

le Rectangle
Cliquez sur l'outil rectangle et en-
trez les dimensions sous la forme

X, XX 5 Y,Yy

le nombre avec décimale la virgu-
le

la dimension sur 'axe des y est
séparée par un point virgule
exemple 5;5 pouruncarréde5 | .
métres

5,5; 8,37 pour un rectangle de
55mpar 8,37 m

Cercle

Outil cercle, donnez le rayon et cliquez

CLiquez sur le bouton droit, Infos sur
I'objet

VOus pourrez modifier les valeurs
directement dans la boite de dialogue
qui s’ouvre

LongJet.r:I ~ 10,02m

[~ cachée [V Projeter des ombres

1 2 C0006_sketchup_outilsDessin



Polygone

Cliquez sur l'outil cercle, bouton
droit, infos sur I'entité entrez le
rayon, puis le nombre de seg-

ments ci contre : 6

™ cachée [+ Projeter des ombres

Arc

Cliquez au point de départ de I'arc, puis au point d’arrivée , ensuite
la valeur de la tangente de I'arc

Outil Comembert et Arc

Donnez le rayon pour le premier point, donnez le sens de ro-
tation puis le point d’arrivée. Cet outil crée une surface fermée

L’outil Arc a coté 17 fait la méme chose mais en créant une
ligne simple sans surface

L’outil Main Levée Scrée un dessin libre
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Cc0007 LES INFERENCES DANS SKETCHUP

Une inférence est un « repére » placé sur différents points de votre construction que SketchUp va
reconnaitre et mémoriser, elles vous permettront de vous « accrocher » aux points, arétes, sur-
faces, au milieu d’'une aréte et méme de pouvoir dessiner des perpendiculaires ou paralléles sans
aucun repeére de construction.

Votre travail sera plus facile, plus rapide et précis, c’est donc un allié de choix que vous devrez
maitriser.

Pour découvrir ce qu’est une inférence, prenez 'outil ligne ( outil ligne ) par exemple puis placez
le curseur de la souris a l'origine des 3 axes (rouge, vert et bleu) sans cliquer, vous remarquerez
que votre curseur s’aimante sur ce point et vous le signale par une pastille jaune et I'inscription
Origine. Si maintenant vous cliquez, vous étes assuré de démarrer votre trait a I'origine des axes.
C’est aussi simple que cela !

Attention, les inférences ne peuvent pas étre désactivés, nous verrons comment les contourner
lorsqu’elles nous génent.

Représentation et couleurs des inférences

Il existe plus d’une dizaine d’inférence différentes, c’est pourquoi elles sont regroupés par catégo-
ries :

Inférences de point

Afin de découvrir ces inférences de point, dessinez une forme a 4 cotés avec I'outil ligne ( outil
ligne ) et en joignant le dernier point au premier de fagon a fermer cette forme et faire apparaitre
une surface :

- Nous avons vu la premiére qui est I'inférence d’origine des axes symbolisée par une pastille
jaune :

Inférence de I'origine des axes

- Chaque point de votre tracé devient une inférence

d’extrémité reconnaissable a sa pastille verte : o [iigine
inference a I'extremite d’une arete

- Les arétes sont également des inférences dés l'instant ou vous placez le

curseur dessus et que vous vous déplacez le long de cette aréte vous verrez A
_apparaltre un rectangle rouge :
inférence d’une arete

- Les arétes proposent en plus une inférence en leur milieu que vous trou-
verez sous forme d’une pastille bleu ciel (a vous de la retrouver car elle n’est pas symbolisée sur
aréte) :

inference du mileu d’'une arete

- Les inférences de surface s’affichent avec un losange bleu
foncé dés l'instant ou votre curseur est placé sur une sur-

face (nous verrons leur utilité plus tard) : /
inference d’une surface

. . . . e \ Paralléle & 'aréte
- Les lignes de guide possédent une inférence a chaque

croisement celles-ci matérialisées par une croix rouge :
inférence a l'intersection de 2 lignes de guide

Inférences de ligne

Les inférences de ligne vont vous permettre de dessiner
des lignes ou des formes primitives parallelement ou per-
pendiculairement a une ligne déja existante et tout cela
sans avoir a tracer une ligne de construction.
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Lorsque que vous tracez une forme vous remarquerez que votre tracé prends suivant son orienta-
tion la couleur d’'un axe (rouge, vert ou bleu), cela vous assure que le trait sera paralléle a cet axe
inférence paralléle a I'axe rougeinférence paralléle a I'axe vertinférence paralléle a I'axe bleu
Parfois vous aurez besoin de tracer une paralléle a une aréte (une ligne) qui n’est pas paralléle a
un des axes. Pour cela :

Placez le premier point de votre tracé,

puis venez poser le curseur de votre souris sur une arete donc vous voulez qu’elle soit paralléle
sans cliquer,

vous obtenez une inférence d’aréte, cela signifie que

SkectchUp garde en mémoire la direction de cette aréte,

déplacez le curseur de la souris dans un axe paralléle a

cette aréte pour que SketchUp vous propose une inférence

de ligne paralléle reconnaissable a sa couleur rose,

cliquez pour placer le second point et tracer votre ligne,

celle-ci est maintenant paralléle. s

dessiner une paralléle a une aréte grace aux inférences =~

Faites de méme si vous désirez obtenir une perpendicu- B At
laire a une aréte déja construite, il vous faudra a I'étape 4

trouver la perpendiculaire. ~

dessiner une perpendiculaire a une aréte grace aux infé-

rences

INnférences de forme

i Square
Les inférence de forme sont des inférences qui vous signale que vous

dessinez un carré (ou un rectangle d’or) lorsque vous utilisez I'outil Rec-
tangle ( icone de I'outil rectangle ) :
inférence pour trouver un carré avec l'outil rectangle

Elles se manifestent également lorsque vous dessinez un demi-cercle

avec l'outil Arc de cercle ( Outil_arc) :

Inférence pour obtenir un demi-cercle avec 'outil arc A

Il en existe aussi pour trouver la tangeante a un arc de cercle, mais Demi-cercle
nous verrons cela plus tard.

Inférences de groupe et composants

Nous verrons un peu plus tard ce qu’est un groupe et un composant, pour I'instant imaginez-le
comme une brique de Lego avec ses arétes et surfaces que vous pouvez manipuler et déplacer.

Sur cette brique de Lego vous allez retrouver toutes les infé-

rences de point (extrémité, aréte, point du milieu, etc) et les infé-

rences de ligne (paralléle et perpendiculaire), simplement pour

reconnaitre visuellement que c’est un groupe ou un composant

les pastilles seront toutes de couleur mauve avec l'information « s/

dans le groupe » ou « dans le composant » : | Extadinind deas be geoupd
inférence avec une extrémité d’'un groupe
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Utiliser plusieurs inférences en méme temps

SketchUp garde en mémoire les inférences que vous ciblez, il est méme capable d’en mémoriser
plusieurs et de différents types. Pour garder en mémoire une

inférence il faut rester une petite seconde sur celle-ci, lorsque

vous voyez l'info-bulle (« extrémité » par exemple), vous étes

sur qu’elle est en mémoire.

Mémorisez votre premiére inférence,allez chercher une autre /

inférence en plagant le curseur de la souris dessus (sans - ethatee it
cliquer) et patientez une seconde jusqu’a voir 'info-bulle,
votre seconde inférence est mémorisée, des axes pointillées
vous guident pour pouvoir les suivre,

vous pouvez essayer de connecter les deux inférences mé-
morisées pour commencer votre prochain tracé.

Tout cela sans aucune ligne ou repére de construction qui
pourrait surcharger visuellement votre scéne.

Forcer une iNnférence

Lorsque vous aurez beaucoup de dessiner des tracés a I'écran, il sera de moins en moins aisé
d’obtenir une inférence de ligne (perpendiculaire ou paralléle) car lorsque vous déplacerez votre
curseur, celui-ci risque de s’accrocher a toutes les inférences qu’il trouvera sur son chemin, et
malheureusement les inférences ne sont pas désactivables sur SketchUp.

Toutefois il existe une solution, c’est de forcer ou d’obliger SketchUp a dessiner votre trait suivant
un des trois axes (rouge,vert ou bleu) grace aux fleches du clavier :

Appuyez une fois sur la fleche de gauche pour forcer a guider votre tracé sur I'axe vert,
Appuyez une fois sur la fleche du haut pour forcer a guider votre tracé sur I'axe bleu,
Appuyez une fois sur la fleche de droite pour forcer a guider votre tracé sur I'axe rouge,

Ré-appuyez une fois sur la fleche du clavier pour désacsupprimer pour la sélectionner

Déplacer un objet o l'aide d'une inférence

Lorsque vous avez besoin de déplacer et positionner un objet par rapport a un autre, il ne faut pas
prendre I'objet (a déplacer) n'importe ou au hasard, servez-vous des inférences. Pour vous aider,
posez-vous toujours cette question : « Quel point (Cad quelle inférence) de mon objet a déplacer
doit correspondre au point (Cad I'inférence) sur lequel je dois
le poser ? »

Vous pouvez a présent faire la manipulation suivante :
déplacer un objet a l'aide des inférences

Sélectionnez I'objet ou le tracé a déplacer en faisant un
double clic sur la surface pour un objet en 2D ou un triple clic
pour un objet en 3D,

prenez I'outil Déplacer ( Outil déplacer/copier ),

cliquez sur le point d’inférence de I'objet a déplacer, votre
objet suit votre souris,

rapprochez et placez le curseur sur le point d’inférence de destination,

vérifiez que I'inférence est bien affichée puis cliquez pour valider le déplacement.
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Cco0010 OUTILS : OUVRIR LE GRAND JeEU
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Pour afficher cette barre d’outils flottante, il suffit de passer par le menu Affichage > Pa-
lette d’outils > Grand jeu d’outils. Elle regroupe les outils les plus utilisés et sont classés
par catégories :

. Les outils de base,

. Les outils de dessin,

. Les outils de modification,
. Les outils de construction,
. Les outils de caméra,

. et les outils de visite.

Les outils de sketchUp ne se limitent pas a la simple barre d’outils, il en existe bien
d’autres que vous aurez besoin d’utiliser ponctuellement suivant votre travail. Vous allez
pouvoir organiser la barre d’outils horizontale sous le menu :

sur PC :Menu Affichage > Palette d’outils puis cochez le type d’outil a afficher ou déco-
chez-le pour le retirer.

Sur Mac :Menu Affichage > Personnaliser la barre d’outils, une fenétre affiche pour
chaque outils une icone et leur nom associés.
Pour supprimer des outils existant dans la barre il suffit de cliquer dessus et de les glisser

en dehors de la barre, a l'inverse pour placer un outil, cliquez dessus et glissez-la dans la barre
sous le menu.

Personnaliser |a barre d'outils S it

------------ (e " -
Je vous conseille de placer les outils Vues standard et e = = L
Styles qui sont utiles a tous projets, pour le reste ce sera s e = o A
en fonction de vos besoins. Notez que ces outils sont tous P = e .
accessibles via le menu principal (menu Caméra > Vues - -~ 2 < £
standard, Menu Affichage > Styles de face, etc), la barre i v B T
y : ’ : p\ S IS il ool Fliboity
d’outils vous permet d'aller plus vite, pensez donc a prendre =~~~ & L e 3
le réflexe pour optimiser votre travail. 2 .- —t et
ezEeec e s omrEar X W
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DEPLACER LES OBJETS

Clic sur un objet simple ou triple clic pour sélectionner I'objet entier
Avec I'outil Déplacer cliquer sur I'objet et cliquez a nouveau sur 'emplacement souhaité

QU'EST CE QUE LINFERENCE DE L'OBJET 2

L'inférence est un "point déterminant” : extrémité, milieu...
Sur I'image ci-contre, l'inférence "extrémité apparait en vert

DEPLACER AVEC LES INFERENCES

Triple Clic sur I'objet

Avec l'outil Déplacer, Cliquer sur un "point chaud” de I'objet
Ici,sur 'angle inférieur droit que nous voyons a I'écran, en-
suite,sans cliquer, déplacez vous sur I'axe qui détermine le
déplacement, cliquez et donnez une valeur

DEPLACER LES OBJETS

Clic sur un objet simple ou triple clic pour sélectionner I'objet Sl

entier
Avec I'outil Déplacer cliquer sur I'objet et cliquez a nouveau
sur 'emplacement souhaité

QU'EST CE QUE LINFERENCE DE L'OBJET 2

L'inférence est un "point déterminant” : extrémité, milieu...
Sur I'image ci-contre, l'inférence "extrémité apparait en vert

DEPLACER AVEC LES INFERENCES

Triple Clic sur I'objet

Avec l'outil Déplacer, Cliquer sur un "point chaud” de 'objet
Ici,sur 'angle inférieur droit que nous voyons a I'écran, en-
suite,sans cliquer, déplacez vous sur I'axe qui détermine le
déplacement, cliquez et donnez une valeur

{Sur 'axe rouge 2.00m
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AIDES AU DESSIN

Dessinez une forme.

Nous voulons créer une ligne paralléle a la ligne AB
VOus cliquez sur le point de départ, puis vous survolez
I'aréte de référence AB, lorsque vous avez l'info bulle
Paralléle a I'aréte, cliquez 4

Paralléle & |'aréte

| TVPE D'INFERENCE COULEUR POSITION
INFER E POMCTUELLE
Extrémité Vert Extrémltedur}e aréte ou d'un
demi-cercle
Point du milieu Bleu clair Milieu d'une aréte
Intersection Maoir Intersection d'une ligne
Sur la face Bleu fonce Surface d'une face
Sur I'aréte Rouge Sur le long d'une aréte
INFERENCE LINEAIRE
Wert
. Sur l'un des 3 axes de la zone
Sur |'axe Bleu .
de dessin
Rouge
Vert En se déplacant sans tracer
A partir du point Bleu d'aréte a partir d'un point
Rouge d'un objet
En se deplagant
Perpendiculaire et paralléle Ligne magenta perpendiculairement ou
parallélement & une aréte
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C0009 DEPLACEMENTS ET COPRPIES

Deplaocement

Réalisez un volume 3 D comme ci contre : 1x1x1,2
Triple CLic pour sélectionner I'élément

Pressez sur la touche Déplacement Copie

Déplacez I'élément de 1 m

:.:

Copie simple

%+ CTRL

Sélecionnez I'élément, Prenez I'outil déplacement ‘ﬁ’ pressez
simultanément sur CTRL
Utilisez l'inférence sur le point inférieur droit, tapez 1

Copie Multiple

Copie de I'élément : Sélection, Outil é’ + Ctrl, Tapez 1 (1m)
puis immédiatement aprés avoir cliqué, tapez x5

Copie et disfribution

Copie de I'élément (1) a 3 m (2) , puis immédiatement
aprés tapez /3

Les 3 éléments sont distribués équitablement sur 'axe
rouge entre le premier et le dernier
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Cco0010 UINTERFACE ET LES PARAMETRAGLES

PARAMETRAGES T e o e —
A e S et
Menu Affichage, développez les barres d’outils, choisir le y OB 7 s i
“grand jeu d’outils” SO . pean
| A s
eC e g b
Menu Fenétre, "Infos ~———— : i 5 :f i e
sur le Modéle” i — o3 e R e o
" U v .
UnlteS . [V Afficher le format des unités "k‘r r.ri::n:‘:lumrthl:lun:mli.
Ne modifiez rien sinon “_Lw::d" 23’ i
cochez sur "afficher e “:f e
I'ancrage de longueur”, ¥ cvertanaage ngiere [50 7] s ST
Mettez 0,1 S =
Le pointeur sera ma- 000 @ |

gnétisé s'il se trouve a

moins de 0,1 cm du point

Cochez ensuite format des unités si vous désirez que celui ci apparaissent avec I'utilisation de
I'outil Cotation
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Cco0010 LES OUTILS De MODIFICATION

Deplacement

Dessiner une ligne avec l'outil crayon i déplacez la ligne avec I'outil déplacement ‘c‘

Copie

Pour copier la ligne c’est le méme outil Déplacement ‘c‘ associé a la touche CTRL

Rotation
J'ai déssiné un rectangle, puis avec I'outil Rotation ™ | cliquer sur une
extrémité, puis sur l'autre ,et entrez un angle

Eechelle

Sélectionnez un rectangle, avec l'outil Echelle i | cliquez et entrez le coeffi-
cient
de réduction (inférieur a 1) ou d’augmentation (sup a 1)

Eexftrusion

L’outil Tirer / Pousser * permet d’extruder des faces (ou surfaces)
Cliquer avec l'outil sur le rectangle, puis tirer vers le haut, et entrez une
valeur

Dessinez a I'aide de I'outil Crayon des lignes comme ci

contre, avec I'outil ‘ , tirer vers le haut, un volume

se crée, les arétes entre le rectangle et les nouvelles

lignes empéchent le rectangle de s’extruder

Avec les mémes lignes de base, tirer vers le bas, dans ce cas, c'est la
face supérieure seule qui est amenée vers le bas

Annulez vos opérations, revenez aux surfaces, et supprimez avec la
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gomme (séléction, et touche SUPPR) les
arétes entre les lignes brisées et le rectangle

L’extrusion se fait maintenant sur la forme
compléte

L’extrusion vers le bas se fait maintenant sur
le volume

Outil Suivez Moi

Tracez d’abord un cercle (sur le plan XY) avec une ligne sur I'axe bleu (2)
Tracez un arc fermez avec une ligne @

‘

Avec l'outil Suivez moi e cliquez a la base de
la surface crée, et suivre le contour du cercle

=N

Outil DECALER

Tracez une forme fermée, avec I'outil Décaler :”5 , cliquer
sur le contour de la forme et amenez la souris d’un c6té
extérieur ou du coté intérieur pour décaler le contour
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Créer une etoile

avec l'outil cercle, dessinez un polygone de 5
cotés et de rayon 3

Dessinez ensuite des lignes pour faire une étoile
- comme ci contre

Avec I'outil GOMME @ cliquez sur toutes les
arétes inutiles

Outil DEPLACER

Avec I'outil deplacer 3:’ Déplacez une pointe de
I'étoile

Vous pouvez déplacer
seulement une zone vous
la déterminez par une
aréte, puis vous déplacez
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Outil Decoler

Avec I'outil décaler cliquer sur une aréte
et donnez une valeur

Outil Pousser Tirer

Cliquer sur la zone a tirer, étirez vers le haut

Outil meftre

CLiquer sur I'outil métre déplacez
hl

1
e 1
- '
1 0
H\ 1 !
T ‘B |Surla ligne|
‘-x I 1 T
\‘ﬁ ! Tog
= .
a8 ! -
[ 0
v

o

Cela permet d’avoir des guides pour dessiner

- Dessinez un rectangle dans I'emplacement des guides, puis avec
I'outil Pousser Tirer, évider la zone

w1
T
|-

2/ 2 C0011_sketchup_modifications2



Cc0012 OUTILS DE BASE

OUTIL SELECTION

RECTANGLE DE SELECTION

L’outil Sélectionner permet de dessiner et
d’étirer un rectangle afin

d’englober les entités a sélectionner.

Il existe deux fagons d’utiliser cet outil sui-

vant ce que vous désirez

selectionner : ~
Sélectionnez 'outil Sélectionner, votre cur-

seur se transforme en

fl éche,

- Eloignez le curseur de votre souris en
haut a gauche de I'entités a sélectionner,
- Cliquez et maintenez enfoncé le bouton gauche de votre souris puis déplacez le curseur en bas
a droite afi n d’englober dans le rectangle continu les entités a sélectionn.

le rectangle de sélection continu disparait, toutes les entités entierement incluses dans ce Re-
lachez le bouton gauche de votre souris,
dans ce rectangle sont sélectionnées et
apparaissent en bleu

Pour selectionner toutes les arétes,sans
pour cela les toucher, choisir le rectangle
de sélection en pointillé, cliquez, maintenez
enfoncé

La touche CTRL vous permet d’ajouter un
élément a votre sélection

La touche MAJ vous permet d’ajouter ou supprimer un élément a la sélection

« Un simple clic vous permet de selectionner une aréte

« Un double clic selectionne les arétes ou faces adjacentes,

« Un triple-clic sélectionne toutes les entités connectées a I'aréte ou la
« face sélectionnée

Menu contextuel (clic droit)

Sélectionnez I'outil Sélectionner, votre curseur se transforme en fl éche,
Un clic droit sur une entité vous ouvre le menu contextuel de celle-ci,
choisissez Sélectionner :

- Arétes englobantes : Toutes les arétes englobant une face seront sé-
lectionnées (cela revient a faire un double-clic).

- Faces connectées : Toutes les faces adjacentes seront sélectionnées.
- Tous les éléments connectés : Toutes les arétes et faces englobantes
seront sélectionnées (cela revient a faire un triple-clic).

- Tous les éléments du méme calque : Sélectionne toutes les entités sur
le méme calque que I'entité sélectionnée.

- Tous les éléments de méme matiére : Sélectionne toutes les entités de
méme matiére que l'entité sélectionnée
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Cco0013 ROTATION DES OBJETS 3D

Ouvrir un élément de la bibliothéque d'images
(Menu Fichier, Banque d’images)
Ici nous avons importé une baie vitrée

Nous désirons la placer sur le cbté B, elle n’est
pas dans la bonne position

Si vous survolez votre baie, vous voyez deux pe-
tites croix rouges, le signe rotation s’affiche &

Faites tourner votre baie et tapez 90

Ces poignées rouges apparaissent sur tous les cotés
du composant
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AnNnNnuler une aoction

A tout moment il est possible d’annuler une action, mais il vous faudra faire la distinction entre une
action en cours (donc non achevée) avec un outil ou une action déja validée :
Annuler une action en cours

Cela signifie que vous avec commencé un travail avec un outil (qui requiére plusieurs étapes) et
qui n’est pas achevé car vous n’étes qu’a une étape intermédiaire.

Annuler une action déja validée

Si par contre vous avez réalisé un tracé et que celui-ci ne
vous convient pas, vous pouvez annuler votre action vali-
dée via le menu Edition > Annuler, vous reviendrez ainsi a
I'étape précédente.

Vous pouvez revenir autant de fois que vous voulez en
arriére via ce menu Edition > Annuler. Et si vous seriez allé V4
trop loin en arriére, vous pouvez toujours revenir en avant -
via le menu Edition > Rétablir pour faire réapparaitre les
actions annulés.

Notez qu’a droite de chaque fonction du menu vous trou-
verez souvent le raccourci clavier qui peut vous faire
gagner du temps. Ici Cmd+Z (sur Mac) ou Ctrl+Z (sur Pc) correspond a Edition > Annuler. Menu
edition > annuler

Je vous conseille de mémoriser ce raccourci car il est le méme dans la plupart des logiciels.

Placer des guides de consfruction

Lorsque I'on dessine, on prépare souvent notre travail en plagant des repéres qui vont servir a
guider nos tracés futurs.

Sketchup nous offre un outil Métre ( outil métre ) qui permet de faire ceci :
Prenez I'outil Métre ( outil métre ),

Lorsque vous approchez le curseur sur un des axes de couleur (rouge, vert ou
bleu) une petite pastille rouge en forme de carré vous assure que vous prenez
bien cet axe comme modéle,prendre un axe comme base de votre ligne de

guidecliquez pour valider ce choix, 9+
éloignez votre curseur dans la direction ou vous voulez placer une ligne de fuevet

guide paralléle a cet axe,définir la ligne de guide tapez la distance désirée
avec les touches numériques du clavier puis enfoncez la touche Entrée pour . . _
valider cette distance,vous obtenez une ligne de guide en pointillée. :
Faites de méme avec un autre axe,ue autre ligne de guide

vous avez a présent des lignes de construction qui vont faciliter vos futurs tracés.
Vous pouvez vous servir de ces lignes de guide pour en tracer d’autres, vous n’étes pas obligé de
reprendre sur les axes de couleurs. Créer une ligne de guide depuis une autre ligne de guide

Si vous désirez supprimer une ligne de guide :

Prenez I'outil Sélectionner ( outil sélectionner ),
cliquez sur la ligne de guide a supprimer pour la sélect
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L’approche de construction en 3D s’apparente a la construction d’'une maquette, on crée les
pieces détachées une par une puis on les assemblent et les emboitent pour aboutir a la construc-

tion finale.
Ufilité des groupes Groupe (1 dans le modéle) a

Calque : |Calquel2l ﬂ

Les inférences sont une aide précieuse a la construction car |
Mo

les objets s’aimantent, mais dés que I'on approche deux piéces
les une des autres et que l'on valide I'inférence, les arétes ou
sommets en contact se collent définitivement et nos pieces n'’en | I~ cachee V¥ Projeter des ombres
forment plus qu’une seule. | werrouilée v Recevoir des ombres
Il n’est plus possible de retrouver nos deux piéces distinctes (a

moins d’'un CTRL + Z (Pc) ou POMME + Z (Mac)).

Pour préserver I'indépendance de chaque piéce et pouvoir modifier la construction a volonté, nous
créerons un groupe pour chacune d’elles.

Créer un groupe

Renommer un groupe dans la fenétre Infos sur I'entité

Sélectionnez les entités (arétes et surfaces) (Outil Sélectionner) a mettre dans le groupe,
faites un clic sur la sélection ou via le menu Edition et choisissez Créer un groupe,
Affichez la fenétre Infos sur I'entité depuis le menu Fenétre,

nommez votre groupe dans le champ Nom.

A présent un seul clic permet de sélectionner votre groupe pour le manipuler, une boite englo-
bante bleu vous indique visuellement que votre sélection est un groupe qui renferme des entitées.

Modifier |l geomeétrie d'un groupe

Boite englobante d’un groupe

Faites un double-clic sur le groupe pour entrer a l'intérieur de
celui-ci et modifier indépendamment les différentes entitées.
Une boite englobante en pointillé apparait autour de votre objet
indiquant que vous pouvez sélectionner et manipuler les enti-
tées du groupe.

Les entitées en dehors de ce groupe sont grisées et ne sont
temporairement plus accessible.

Pour sortir du groupe, cliquez dans un espace vide de votre vue
3D.

Eclater un groupe

Pour supprimer un groupe et libérer les entitées de celui-ci :

Sélectionnez-le (Outil Sélectionner),

faites un clic sur la sélection ou via le menu Edition > Groupe et choisissez Eclater.

Pensez a éclater vos groupes a I'écart de toute géométrie pour éviter que les sommets et arétes
en contact ne se soudent et ne forment plus qu’un.
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Structure et hiérarchie des groupes

Une fois vos groupes réalisés et nommés, vous allez commencer a les assembler, les emboiter
les uns aux autres pour en faire un ensemble.

Jusqu’a présent ces groupes sont tous indépendant, pour faciliter leurs sélection et leurs déplace-
ment il devient intéressant de les grouper en suivant un lien de parenté.

Nous prendrons exemple d’une corbeille contenant plusieurs fruits le tout posé sur une table.

= '.stru.r.tu.ut = 'stn.m..ure z E.n.-ﬁ.clure

Filtre : | b Fillre ; | n | Fillre | b Filkre - | D
[E] Sans titre [E] Sans titre | [E) Samns titre & Sans titre

m Corbedls m Corbede = m Corbedls = m Tabla

m Oranges = m Fruks = m Fruits = m Corbeile

m Pommes m Oranges m Cwanges = m Fruks

m Raksing m Pommes m Pomemes m Oranges

m Tabds m Ralsing m Ralsing m Fomines

m Table m Tabés m Faising

Affichez la structure des groupes de votre scéne via le menu Fenétre > Structure.

Les fruits, la corbeille et la table sont tous au méme niveau, si vous voulez tout déplacer, il vous
faudra tout sélectionner.

Nous allons donner un lien de parenté (une hiérarchie) a ces groupes pour n’avoir qu’a déplacer la
table, la corbeille et les fruits suivront :

Parenter des groupes depuis la fenétre Structure

Commencgons par regrouper les fruits, sélectionnez-les (Outil Sélectionner) puis faites un clic droit
et choisissez Créer un groupe que vous nommerez Fruits dans la fenétre Infos sur I'entité,

pour lier les fruits a la corbeille, dans la fenétre Structure cliquez et glissez Fruits sur la Corbeille,
pour lier la corbeille a la table, dans la fenétre Structure cliquez et glissez Corbeille sur la Table.

A présent si vous cliquez sur un fruit, la corbeille ou la table, c’est toujours le parent qui est sélec-
tionné (dans notre exemple la table).

Si vous désirez bouger 'emplacement de la corbeille sur la table, cliquez sur Corbeille dans la
fenétre Structure et déplacez la.
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.m Outil Crayon

. S‘) Vous pouvez tracer des lignes en cliquant simple-
ment sur votre dessin, vous remarquerez que Si

O 6’ vous ne sortez pas de I'outil (sans faire echapp)
vous n’avez pas besoin de cliquer sur les deux

E 7 points, le point suivant suffit, cela s’appelle une
polyligne

Traceés précis -

Pour avoir un tracé précis, vous donnez une valeur et vous
cliquez ensuite. La valeur s’affiche en bas a gauche de votre
écran

Lorsque qu’un point de la polyligne rejoint le premier point, elle

provoque une suface fermée et se teinte en gris

On peut tracer des lignes a l'intérieur de la surface existante
Utiliser les points d’inférence pour s’accrocher

le rectongle

Cliquez sur l'outil rectangle et en-
trez les dimensions sous la forme

X, XX 5 Y,Yy

le nombre avec décimale la virgu-
le

la dimension sur 'axe des y est
séparée par un point virgule
exemple 5 ;5 pourun carré de 5
métres

5,5; 8,37 pour un rectangle de 5,5 m par 8,37 m

le cercle
Outil cercle, donnez le rayon et cliquez

CLiquez sur le bouton droit, Infos sur |

Fobjet s etk S

VOus pourrez modifier les valeurs 2

directement dans la boite de dialogue Z‘“L‘;ﬁ‘{m_ =
'] yor: | ~

qui s’ouvre Seqnents:| 27

Longueur:l ~ 10,02m

[ Cachée [¥ Projeter des ombres

polygone
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Cliquez sur l'outil cercle, bouton droit, infos sur I'entité entrez le rayon, puis le nombre de seg-
ments ci contre : 6

l'orc

™ cachée [+ Projeter des ombres

Cliquez au point de départ de
I'arc, puis au point d’arrivée , en-
suite la valeur de la tangente de 'arc

Outils comembert et arc

Donnez le rayon pour le premier point, donnez le sens de rotation
puis le point d’arrivée. Cet outil crée une surface fermée

L’outil Arc a coté 17 fait la méme chose mais en créant une
ligne simple sans surface

L’outil Main Levée Scrée un dessin libre
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Outil CALQUES

L’outil Calques v Laverd |'permet de placer vos sélections sur des o o
. I ~ , , . algues
calques, il est conseillé (plutdt que d’encombrer votre barre d’outil) de @0 N
toujours garder ouverte la fenétre Infos sur I'entité qui contient cet outil. " Nom i Visible | Cou.. |
. . ~ . . s . . @Lavero g
Le principe des calques est légerement diff érent des logiciels de dessin O Murs extériewrs @ [

en PAQ, ici leur hiérarchie n’a pas d’importance, ils servent uniquement a

placer (et ranger) vos sélections sur des calques et ont pour réle principal

d’affi cher ou masquer ces calques pour aciliter le travail et la lisibilité de

votre scéne.

Pour affi cher la fenétre de calques, utilisez le menu Fenétre > Calques.

Le calque actif (celui sur lequel vous dessinez) est par défaut le calque .
0 (LayerO0).

CREER/SUPPRIMER UN CALQUE

Le calque 0 est le calque par défaut, il ne peut ni étre supprimé ni changé de nom. Par défaut
c’est sur ce calque que sont placés tous vos tracés.

Pour créer un calque, enfoncez le bouton en haut a gauche de la fenétre, un nouveau calque
viens se placer en bas de la liste, donnez lui un nom explicite qui représentera les entités que ous
placerez dedans puis validez par la touche Entrée.

En cliquant dans le cercle a gauche de son nom, la pastille noire passe sur ce calque et il devient
le calque actif, celui sur lequel seront placés vos prochaines tracés.

Pour supprimer un calque, cliquez une fois sur son nom pour le mettre en sur brillance puis cli-
quez sur le bouton en haut a gauche de la fenétre.

Si ce calque possédait des entités (aréte, face, cotation, ...), SketchUp vous demande ce qu’il doit
en faire :

- déplacer les entités du calque sur le calque par défaut (calque 0),

- déplacer les entités du calque sur le calque actif (celui avec la pastille noire a gauche de son
nom),

- ou supprimer les entités présentes sur ce calque.

PLACER/DEPLACER UNE SELECTION SUR UN CALQUE

Avant tout, pensez a créer vos calques et a les organiser.

Attention : il est conseillé de ne placer sur les calques que les groupes et/ou composants, en
effet, vous pouvez placer des arétes et surfaces sur un calque, mais ces mémes arétes et sur-
faces peuvent faire partie d’'un groupe qui lui peut étre placé sur un autre calque, ce qui ameéne de
grandes confusions et fi nissent par décourager l'utilisation des calques.

1- Sélectionnez () la/les entité(s) a placer ou déplacer sur un calque,

2- Affi chez soit la fenétre Infos sur I'entité, dans cette fenétre se trouve

I'option Calque avec un menu déroulant,

3- soit I'outil Calque dans la barre d’outils en haut,

4- choisissez dans le menu déroulant des calques celui sur lequel vous désirez placer votre sélec-
tion.

Sur Pc, pour affi chez I'outil Calque (), pour cela rendezvous dans le menu Affichage > Barre
d’outils > Calques.

Sur Mac, l'outil Calque () est accessible par le menu Affichage > Personnaliser la barre d’outil,
puis glissez I'outil dans la barre d’outil en haut.
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Menu Fichier, Banque d’'images 3D

Je tape le mot clé "door” , je choisis un modele

Il faut faire pivoter le modéle sur un plan vertical

Avec l'outil Rotation, Déplacez jusqu’a ce que vous obte-
niez le raporteur ROuge car nous devons faire pivoter sur
I'axe rouge

Lorsque celui ci s’affiche en rouge, prenez deux points sur la
largeur inférieure de la porte et faites pivoter lorsque s’af-

= _—

fiche I'info bulle "sur I'axe bleu _.I Exrémité dans le aroupe

Matiéres =
I Métal_ader_texturé_bla E

od
N

Couleur

Moaodifier laspect Nuander:[Color wheel <] | of

Texture

W Utiliser l'mage de texture
|Me13|_stee|_Termred_White.j F &

<->|~0r15m } ™ Colorier
[H]

t [~0,15m .Réi'iﬁaiserl.a
couleur

Double clic surle composant, a I'aide de I'Outil
Pot de Peinture

Choix de la couleur et de la nuance

Choix de la texture

Opacité

[ | 0 =
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Mise o lI'echelle

Cliquer sur 'outil Echelle K

Cliquer sur une des poignées, et mettez un facteur d’echelle

2/ 2 C0017_sketchup_banquelmage



coots

L’outil Créer un composant permet d’enregistrer les entités sélectionnées comme composant, cela
vous permettra de le réutiliser dans votre projet a plusieurs reprises mais aussi de le sauvegarder
dans la bibliothéque de composants pour d’autres projets.

Le fonctionnement est similaire a la création d’un groupe, la diff érence réside dans 'alignement,
la copie et la duplication.

Les composants, a la diff érence des groupes, ont la possibilité de s’aligner directement sur les
surfaces que vous pointez.

La ou un groupe et ses copies sont indépendantes les une des autres, les composants et leur
opies sont elles liées et héritent des transformations de géométrie :

Modifier la géométrie d’un groupe n’as pas d’eff et sur ses copies.

Modifier la géométrie d’'un composant répercute cette modifi cation sur ses copies.

— s |
Mise a I'échelle , Faire pivoter ®# et Colorier @
PREPARER SON FUTUR COMPOSANT

Un composant peut étre enregistré dans une bibliothéque puis utilisé dans d’autres fi chiers (a la
diff érence des groupes).

Pour faciliter I'intégration d’'un composant sur une surface existante il faut —
défi nir le plan du composant qui sera en contact avec les surfaces de cette - T
géométrie. o

Prenons I'exemple d’'un composant « fenétre PVC » que I'on placera sur un
batiment :

sur 'image, le plan du futur composant « fenétre PVC » qui va entrer en
contact avec les murs

du batiment est le plan XZ (rouge/bleu).

Or lors de la création d’'un composant, SketchUp utilise par défaut le plan XY (r
faire pivoter (comme plan de contact, il faut) cette fenétre PVC (autour de I'axe
Vous pouvez maintenant passer a I'étape de création d’'un composant.

CREER UN COMPOSANT

- Sélectionnez les entités (arétes et faces) ( ) qui deviendront votre compo- ...
sant,
- Cliquez sur I'outil Créer un composant ( ) ou faites un clic droit sur votre .

sélection puis choisissez Créer un composant, ,

- Une fenétre fl ottante apparait : e
1- Donnez-lui un nom et une description (facultative), e ——
2- choisissez une Liaison quelconque, une surface grisée vient se placer ;
sur le plan XY (rouge/vert), elle correspond au plan qui entrera en contact |~ m‘“‘“*‘“°"°”';:::““
avec les faces du batiment, —

3- cliquez sur Définir les axes du composant, pour choisir I'extrémité de
référence pour positionner la « fenétre PVC ».

Cliquez une premiére fois pour définir 'origine des axes, déplacez le cur-
seur pour indiquer la direction de I'axe rouge et cliquez pour valider, dépla-
cez le curseur pour indiquer la direction de I'axe vert et cliquez pour valider,
4- cochez la case Remplacer la sélection par le composant pour que votre
sélection devienne elle aussi un composant

5- validez en cliquant sur le bouton Créer.

Nom ! |FenétrePYC

1/ 3 C0018_sketchup_composants



Options

La Liaison quelconque est la plus polyvalente, votre composant s’alignera perpendiculairement
sur toutes les surfaces du batiment (méme les surfaces inclinées).

La Liaison horizontale sera toujours a plat sur I'axe XY (rouge/vert) et ne tiendra pas compte de
I'orientation des faces du batiment, cela peut étre utile pour des composants qui quoi qu'il arrive
doivent rester droit comme un arbre.

La Liaison verticale aligne le composant perpendiculairement sur les surfaces du batiment sauf les
surfaces inclinées (comme sur la pente de toit par exemple).

La Liaison inclinée aligne uniquement le composant perpendiculairement sur les surfaces inclnées
du batiment.

Découper une ouverture découpe automatiquement la surface en contact avec le composant et
supprime I'excédent. Attention, cela ne fonctionne que sur une surface plane et non une surface
extrudée (avec une épaisseur).

MODIFIER UN COMPOSANT

Pour retrouver et utiliser un composant nouvellement créé, ouvrez le menu Fenétre > Compo-
sants, une fenétre fl ottante s’affi che, trois onglets (Sélectionner, Modifier et Statistiques) sont
présents dans cette fenétre :

1- Cliquez sur 'onglet sélectionner,

2- cliquez sur I'icone représentant une maison, elle permet d’afficher les composants présents
dans votre fichier,

3- Cliquez sur le composant a utiliser dans votre scéne,

4- déplacez le curseur de votre souris dans la vue 3D, votre composant est accroché au curseur
de votre souris,

5- placez le composant dans la vue et cliquez pour valider.

Il est possible de revenir sur les options d’'un composant, pour cela cliquez sur 'onglet Modifier :
1- Modifiez son nom et sa description si nécessaire,

2- modifiez son alignement et ses options si nécessaire.

Pour redéfinir les axes du composant, faites un clic droit sur le modeéle initial (ou une des copies
du composant) dans la vue 3D puis choisissez Modifier les axes.

ReNDRE& UNIQUE UN COMPOSANT

Un des avantages des composants c’est lorsque I'on modifi e sa géométrie les autres subissent
les mémes modifi cations sauf que parfois cette modifi cation n’est pas désirée.

Pour ce genre de cas, il est possible de Rendre unique un composant, c’est a dire de faire en
sorte qu'’il ne subisse plus les modifi cations appliqués aux autres composants, mais attention
cette démarche n’est pas réversible.

Sélectionnez le composant puis faites un clic droit et enfi n choisissez I'option Rendre unique (il
vous faut au moins 2 composants identiques dans votre document pour avoir cette option).

SAUVEGARDER UN COMPOSANT DANS SA BIBLIOTHEQUE

Si un composant vous plait, vous pouvez le sauvegarder sur votre disque dur pour le réutiliser
dans d’autres projets, c’est a dire que pour chaque futur fi chier SketchUp vous pourrez faire appel
a une liste de composants sauvegardés.

La méthode est particuliére sur SketchUp :

1- Sélectionnez le composant a sauvegarder, Fenétre > Composants,

3- cliquez sur I'icone

2- affichez la palette composants via le menu

puis choisissez Créer une collection locale, cette option permet simplement de créer un dossier
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vierge qui vapermettre de faire la liaison entre SketchUp et votre disque Composants =
a

dur, cette étape est primordiale car si vous créez un dossier directement r
sur votre disque dur sans passer par SketchUp, celui-ci ne le reconnaitra @
pas.
Notez que cette étape est facultative, si vous avez déja crée un dossier « | <= | & setssaes]
chaises » par exemple et que vous désirez ajouter un nouveau composant =@l 2 E’
de chaise, passez directement a I'étape suivante. 3
4- sélectionnez votre composant dans la fenétre Composants, si vous ne le
trouvez pas, cliquez sur I'icone qui affi chera tous les compo
Dermick
s nar Sketchlin h
¢ Dans le modéle e
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cooto

1- Bibliothéques de composants

Un composant est un ensemble de lignes et de faces représentant un objet. Contrairement a ur
groupe (composé d'objets lui aussi), un composant est destiné a étre réutilisé et dupliqué. A cette fir
on peut lui attribuer des caractéristiques de comportement et I'enregistrer dans une collection.

Exemple : http://sketchup.google.com/3dwarehouse/?hl=fr

Dans Sketchup, vous avez accés a ces composants via « Fenétre > Composants » ou Fichier :
Banque d’images 3D > télécharger des modéles ».

Composants X] Certaines bibliotheques sont sur votre ordinateur, d'autres son
| o disponibles sur Internet et accessibles depuis le logiciel.

@ | Exemples :

Sélectionner | Madifier | Statistiques | - Pories, jencires

Evv| LBl - Veégétaux

| Bame-ammature_acier il et Personn ages
@ - Voitures

" | Charpente_bois - Piscine, etc...

| Connexions

| Couverture_détails

hd
I

Il suffit de taper ce que vous recherchez dans la barre de recherche. Une recherche en anglais
augmente vos chances de trouver ce que vous cherchez.

17'
N a

i [ o smaer 0 s i ey
\VJ | #-Trimble banqued'lmageiiff E::,,,: e

! - o 1 Un arbre a vandosuvre (54500) tramsties par Yzt B e 34 Orzose 2007
| ﬂl | arbrm F=0-2 sape [ Canw | Swwet vaw | Modals congu & Maide de Sketchiip ‘?
‘Ca madaie 2 eté cred 3 Fande de Sketchilp un outil de.
‘wodéisation X0 de Geogle En sana phes »
pai'Tocotd
un aibe & vandosuvie-lEsnancy [T ——— dble
(545001 c'est gioz marronies
- EY,
s = 2 S L)
arbee aslone cobellin
Collections t modtles azsacies
Satien modbien du Yuzsi
Asbwes Dy Soume Capesux (., ]
parglian 1 . {
- Aubres présents aur le squars. Wy $:;': .u. b g o155 v | *
(o —— g x| 3
R  Flay tfdd o G £ .
s pubathamflindl e Do s v e sy D SIACICEL e posis b e
FPavarue Heib Borquba
- Arbres Du Square Walleau |... 2 M P
i parielian Charger dans le modéle 7 %) Progression du téléchargement... E
Aubres présenis dan le squaie
| 1 \p Charger ceci directemarit dans votre madéle Sketchiip ? Octets lus : 741376 i

56%

ARBRE 20
par FIGHOUF
arbee pout paics e jardin
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* Si un composant a été dupliqué, la modification d'un
composant entraine la modification de toutes les copies.

Pour modifier un composant indépendamment des autres
copies, il faut le rendre unique.

« Bouton droit de la souris > Rendre unique. »

Cependant, cela peut étre trés pratique de modifier toutes les
copies pour mettre en forme toutes les fenétres d'une maison
en méme temps par exemple.

. L'utilisation des composants accélere le travail de
traitement de Sketchup. En effet, plusieurs copies d'un
composant sont moins volumineuses que plusieurs copies d'une
entité ou d'un groupe.

2- Création de composants

Une fois l'objet modélisé, sélectionnez le (triple clic dessus ou sélection par encadrement avec le
pointeur) puis « Bouton droit de la souris > Créer un composant ».

Créer un composant
I

zéngral

- Alignement - Liaison :
Mo Im
- Aucune : le composant pourra étre

Description : . ST
5 déplacé librement
- Quelconque : le composants colle aux
Alignement faces. Hori | | i
olson't [Mucms =] DA s xes o composant - orizontale : le composant ne s'insére

que sur une face horizontale.

- Verticale : le composant ne s'insére que
sur une face verticale.

- Inclinée : le composant ne s'insere que
v Remplacer la sélection par le composant sur une face inclinée.

Annuler ‘ Créer |

—  Découper une ouverture : le composant découpe la face sur laquelle il est inséré suivant

son plan de liaison. Pour que le positionnement se fasse correctement il est important de bien
placer les axes du composant.

|

| Toujours falre face & la caméra

-

—  Toujours faire face a la caméra : permet a un modéle 2D d'étre toujours orienté de face
quand on tourne autour du modele.

3- Utilisation des composants
Pour gérer un composant, on peut utiliser le menu « Fenétre > Structure ».

On peut, avec le bouton droit :
:;,Lm _ [ Masquer un objet du composant

=- i <Un arbre a vandoeuvre (S4500)>

- Révéler un objet
- Remplacer un objet
- Sélectionner un objet
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| est également possible de créer des copies d'un composant a I'aide de I'outil « Faire pivoter ».

— Sélectionner le composant puis sélectionner I'outil « Faire pivoter » et cliquer sur « Ctrl »
pour passer en mode « copie ».

— Cliquer une premiére fois pour déterminer le centre de la rotation.
— Cliquer une seconde fois sur le composant
— Saisir un angle de rotation en degré (45 par exemple) puis faire « Entrée »

— Saisir *7 pour créer 6 composants supplémentaires chacun distant de 45°.

3 Angle }45

Puis Entrée

4 Angle }"?

9 + Ctrl

Puis Entrée

5
3.2- Intersection de composants

-a commande « Bouton Droit > Intersection des faces > Avec le modéle » est trés utile pour
créer des arétes entre un composant et le modéle Sketchup.

Zoom étendu

Déformation ibre

Fredoscale

SUZKT: Replsce by proxy object

Composants dynamiques

Aprés avoir créer des intersections, on peut
supprimer la pelouse au milieu de la piscine.

3.3- Eclater un composant

_a commande « Bouton Droit > Eclater » est trés utile pour modifier un composant.
| o |

Recharger

Une fois le composant éclater, on peut par

B s exemple, changer la couleur de la bache.

Modifier les 4xet

Fteepmtiondes faces
Rietoumes e long de

Baom dtenh

Difomapion ey

Feadotsie .
‘SUZKT: Replace by vy sbiect

Compaants desamigus
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4- Travailler en groupe

Il est possible d'enregistrer les composants dans un autre fichier. Cela permet de se partager le
travail de modélisation.

On peut, par exemple, partir d'une vue aérienne et modéliser grossierement chaque batiment puis
les enregistrer chacun dans un fichier différent.

Chaque batiment peut alors étre modéliser de fagon indépendante ou étre intégré a une bibliothéque
(partager sur le web éventuellement).

Erwegever gans - [ e = e@om-

Infos sur l'entité
Effacer
Masquer
Verrouiller

Modifier le composant

Rendre unigue

Eclater

Mo fchier - [picner kg
Iree [Modsies Skenchip ™ siph

i

Détacher

Recharger

Enregi oS
Partager le composant...

Modifier les axes
Reinitialiser I'echelle
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c0020

Une inférence est une méthode qui permet a SketchUp de déduire une information et par consé-
quent de pouvoir vous aligner sur une extrémité, une aréte, le milieu d’'une aréte, une surface,
mais également sur un axe, perpendiculairement ou parallement a une aréte ...

Ces inférences vous font gagner du temps et allégent votre scéne en vous évitant d’y placer une
multitude de repéres.

Maintenir la souris (sans cliquer) sur une inférence durant 1
seconde vous indique le type d’inférence dans une infobulle.
Les inférences ne peuvent pas étre désactivées.

Avec I'outil crayon, si vous vous déplacez horizontalement,
attendez d’avoir le guide ligne rouge, de méme que pour tracer un trait sur 'axe des Y , attendez
d’avoir le guide Vert

Pour étre paralléle a une aréte,
déplacez vous sans cliquer sur
I'aréte guide

Sur 'axe rouge

Avec I'outil crayon, lorsque
vous étes en A, se déplacer
sans cliquer sur B, un guide
apparait, il s’arrete a la hauteur
du point B, idem en C avec le
point D

INférences de point

« Un point jaune pour l'origine des axes,

« un point vert pour une extrémitée,

« un point bleu ciel pour le milieu d’'une aréte,
« un rectangle rouge le long d’'une aréte,

« un losange bleu foncé pour une face,

INféerences de ligne

Paint du milieu

. L
Sur la face Sur l'aréte

Une inférence de ligne correspond la ligne qui sépare l'inférence de point du curseur de votre
souris.

« une ligne rouge pour un déplacement sur
I'axe rouge, paralléle a I'axe rouge d’origine,

« une ligne verte pour un déplacement sur
'axe vert, parallele a I'axe vert d’origine,

« une ligne bleu pour un déplacement sur I'axe bleu, paralléle a 'axe bleu d’origine,

« une ligne pointillée noire pour un déplacement quelconque a partir du point.

INférences de forme

Une inférence de forme vous aide dans vos tracés pour obtenir des demi-cercles ou des carrés.
Inférences de groupe et de composants :

Lorsque I'on place le curseur sur I'inférence d’'un groupe ou d’'un composant, celui-ci sera toujours
de couleur magenta, de plus l'infobulle précise "dans le groupe” ou "dans le composant”.

Sur l'axe vert

.. ] Sur I'axe bleu

Utiliser une iNnférence
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Prennez votre outil de construction (ligne ,rectangle)puis approchez le curseur de votre souris sur
une extrémité (sans cliquer), celui-ci s’aimante sur le point d’inférence et vous le signale par un
point de couleur et une infobulle,

a présent déplacez-vous parallélement a 'un des axes (rouge, vert ou bleu) et vous obtenez une
inférence de ligne,

grace ces inférences, vous avez la sécurité de commencer un tracé sur le méme axe. Sans ces
inférences vous auriez d0 tracer une ligne de construction pour suivre le méme axe.

Utiliser plusieurs inférences en méme temps

SketchUp garde en mémoire les inférences que vous ciblez, il

est capable d’en mémoriser plusieurs et de différents types.

Pour placer un point ou démarrer un tracé dans le vide en /
vous alignant sur deux points : " [A parti du point
Double inférence de point

Prennez votre outil de construction (ligne,Rectangle) puis ap-
prochez le curseur de votre souris sur une des extrémité (sans
cliquer), attendez que l'infobulle apparaisse (cela signifie qu’il
a gardé l'inférence en mémoire),

déplacez-vous sur 'autre extrémité (toujours sans cliquer) et attendez que l'infobulle apparaisse,
vos deux inférences sont mémorisées, déplacez-vous le long de I'axe de la derniére inférence
jusqu’a rencontrer le premier axe d’'inférence,

Cliquez pour placer votre point ou commencer votre tracé.

Cela vous a évité de devoir placer deux lignes de construction et de surchager visuellement votre
scene.

Forcer une iNference

Lorsqu’il y a trop d’extrémité ou d’aréte dans votre scene, il est difficile de maintenir une inférence
de ligne.

Vous pouvez alors forcer a maintenir une inférence suivant un des trois axes (rouge, vert ou bleu)
Prennez votre outil de construction (ligne (Icéne outil Ligne), rectangle (Icéne outil Rectangle), ...)
et placez le sur votre inférence de départ (sans cliquer),si vous désirez commencer votre tracé sur
ce point cliquez pour le valider, si vous désirez vous servir d’'une ligne d’inférence pour commen-
cer votre tracé plus loin ne cliquez pas,enfoncez une des touches directionnelle du clavier :

« La fléche de droite force une inférence de ligne sur I'axe rouge (X),
« La fléche de gauche force une inférence de ligne sur I'axe vert (Y),
« La fléche du haut force une inférence de ligne sur I'axe bleu (Z),

relachez la touche du clavier et déplacez votre curseur vers le second point d’'inférence, une ligne
continue (si vous avez cliqué a I'étape 2) ou pointillé ou continue (si vous n’avez pas cliqué a
I'étape 2) apparait et une infobulle vous indique Contraint sur I'axe ...,vous étes maintenant libre
de vos mouvements pour aller chercher le second point d’'inférence,Cliquez pour placer votre point
ou commencer votre tracé.

Déplacer et positionner suivant les iNnférences

Quand vous cliquez sur une entité (aréte, sommet, face, ...), SketchUp mémorise la position du
clic pour en faire une inférence, par conséquent ne cliquez pas au hasard sur un objet pour le dé-
placer, posez-vous la question : quelle inférence dois-je déplacer et sur quelle inférence la poser ?

Deéplacer une selection depuis les iNférences

Sélectionnez (Icéne outil Sélectionner) la ou les entités a déplacer,
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prennez I'outil de déplacement (Icdne outil Déplacer/Copier),
cliquez sur le point d’inférence de I'objet a déplacer,
rapprochez et placez le curseur sur le point d’inférence de dest;

cliquez pour valider.
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c0020

Import d'une image

hab Fichier JFa L

M(_apu Fichier --> Importer --> Fichier , cocher 'option .42 Fichier 126 o
Utiliser comme image 135 Fichier JPG S |
133 Fichier PG ' Utiiser comme image
130 Fichier JPG " Utiiser comme texture
1:44 Fichier JPG e ﬁmm*
121 Fichier IPG -

Avec I'outil Métre “B mesurez la longueur totale de la
maison sur le plan, dans notre cas, cela fait 6.13 m
alors qu’elle fait réellement 13.75 m

Nous faisons la division 13.75/6.13 pour trouver
notre coefficient : 2.24

Eechelle

Clic sur I'image, outil Echelle K
Cliquez sur une poignée, étirez, cliquez et tapez 2.24

Vous pouvez maintenant dessiner sur le plan
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Cc0050 LES INFERENCES DANS SKETCHUP

Une inférence est un « repére » placé sur différents points de votre construction que SketchUp va
reconnaitre et mémoriser, elles vous permettront de vous « accrocher » aux points, arétes, sur-
faces, au milieu d’'une aréte et méme de pouvoir dessiner des perpendiculaires ou paralléles sans
aucun repeére de construction.

Votre travail sera plus facile, plus rapide et précis, c’est donc un allié de choix que vous devrez
maitriser.

Pour découvrir ce qu’est une inférence, prenez 'outil ligne ( outil ligne ) par exemple puis placez
le curseur de la souris a l'origine des 3 axes (rouge, vert et bleu) sans cliquer, vous remarquerez
que votre curseur s’aimante sur ce point et vous le signale par une pastille jaune et I'inscription
Origine. Si maintenant vous cliquez, vous étes assuré de démarrer votre trait a I'origine des axes.
C’est aussi simple que cela !

Attention, les inférences ne peuvent pas étre désactivés, nous verrons comment les contourner
lorsqu’elles nous génent.

Representation et couleurs des inférences

Il existe plus d’une dizaine d’inférence différentes, c’est pourquoi elles sont regroupés par catégo-
ries :
Inférences de point
Afin de découvrir ces inférences de point, dessinez une forme a 4 cotés avec I'outil ligne ( outil
ligne ) et en joignant le dernier point au premier de fagon a fermer cette forme et faire apparaitre
une surface :
- Nous avons vu la premiére qui est I'inférence d’origine des axes symbolisée par une pastille
jaune :
Inférence de I'origine des axes
- Chaque point de votre tracé devient une inférence
d’extrémité reconnaissable a sa pastille verte :
inference a I'extremite d’une arete < i

A . o o E - |Ongine
- Les arétes sont également des inférences dés l'instant
ou vous placez le curseur dessus et que vous vous déplacez le long de cette
aréte vous verrez apparaitre un rectangle rouge : g A
mferencia d’'une arete o N
- Les arétes proposent en plus une inférence en leur milieu que vous trouve-
rez sous forme d’une pastille bleu ciel (a vous de la retrouver car elle n’est
pas symbolisée sur I'aréte) :
inference du mileu d’'une arete
- Les inférences de surface s’affichent avec un losange bleu foncé dés I'instant ou votre curseur
est placé sur une surface (nous verrons leur utilité plus tard)

inference d'une surface 7/
- Les lignes de guide possédent une inférence a chaque .
croisement celles-ci matérialisées par une croix rouge : ot

inférence a l'intersection de 2 lignes de guide

Inférences de ligne

Les inférences de ligne vont vous permettre de dessiner
des lignes ou des formes primitives parallelement ou per-
pendiculairement a une ligne déja existante et tout cela
sans avoir a tracer une ligne de construction.

I1_?r§que que vous tracez une forme vous remarquerez que
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votre tracé prends suivant son orientation la couleur d’'un axe (rouge, vert ou bleu), cela vous as-
sure que le trait sera paralléle a cet axe

inférence paralléle a I'axe rougeinférence paralléle a I'axe vertinférence paralléle a I'axe bleu
Parfois vous aurez besoin de tracer une paralléle a une aréte (une ligne) qui n’est pas paralléle a
un des axes. Pour cela :

Placez le premier point de votre tracé,

puis venez poser le curseur de votre souris sur une arete donc vous voulez qu’elle soit paralléle
sans cliquer,

vous obtenez une inférence d’aréte, cela signifie que

SkectchUp garde en mémoire la direction de cette aréte,

déplacez le curseur de la souris dans un axe paralléle a

cette aréte pour que SketchUp vous propose une inférence

de ligne paralléle reconnaissable a sa couleur rose,

cliquez pour placer le second point et tracer votre ligne,

celle-ci est maintenant paralléle. s

dessiner une paralléle a une aréte grace aux inférences =~

Faites de méme si vous désirez obtenir une perpendicu- B At
laire a une aréte déja construite, il vous faudra a I'étape 4

trouver la perpendiculaire. ~

dessiner une perpendiculaire a une aréte grace aux infé-

rences

INferences de forme

i Square
Les inférence de forme sont des inférences qui vous signale que vous

dessinez un carré (ou un rectangle d’or) lorsque vous utilisez I'outil Rec-
tangle ( icone de I'outil rectangle ) :
inférence pour trouver un carré avec l'outil rectangle

Elles se manifestent également lorsque vous dessinez un demi-cercle

avec l'outil Arc de cercle ( Outil_arc) :

Inférence pour obtenir un demi-cercle avec 'outil arc A

Il en existe aussi pour trouver la tangeante a un arc de cercle, mais Demi-cercle
nous verrons cela plus tard.

INférences de groupe et composants

Nous verrons un peu plus tard ce qu’est un groupe et un composant, pour I'instant imaginez-le
comme une brique de Lego avec ses arétes et surfaces que vous pouvez manipuler et déplacer.

Sur cette brique de Lego vous allez retrouver toutes les infé-

rences de point (extrémité, aréte, point du milieu, etc) et les infé-

rences de ligne (paralléle et perpendiculaire), simplement pour

reconnaitre visuellement que c’est un groupe ou un composant

les pastilles seront toutes de couleur mauve avec l'information « s/

dans le groupe » ou « dans le composant » : | Extadinind deas be geoupd
inférence avec une extrémité d’'un groupe

Utiliser plusieurs inférences en méme temps
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SketchUp garde en mémoire les inférences que vous ciblez, il est méme capable d’en mémoriser
plusieurs et de différents types. Pour garder en mémoire une inférence il faut rester une petite
seconde sur celle-ci, lorsque vous voyez l'info-bulle (« extrémité » par exemple), vous étes sur
gu’elle est en mémoire.

Mémorisez votre premiére inférence,allez chercher une autre

inférence en plagant le curseur de la souris dessus (sans

cliquer) et patientez une seconde jusqu’a voir 'info-bulle, d

votre seconde inférence est mémorisée, des axes pointillées [ partir du point
vous guident pour pouvoir les suivre,

vous pouvez essayer de connecter les deux inférences mé-
morisées pour commencer votre prochain trace.

Tout cela sans aucune ligne ou repére de construction qui
pourrait surcharger visuellement votre scéne.

Forcer une iNference

Lorsque vous aurez beaucoup de dessiner des tracés a I'écran, il sera de moins en moins aisé
d’obtenir une inférence de ligne (perpendiculaire ou paralléle) car lorsque vous déplacerez votre
curseur, celui-ci risque de s’accrocher a toutes les inférences qu’il trouvera sur son chemin, et
malheureusement les inférences ne sont pas désactivables sur SketchUp.

Toutefois il existe une solution, c’est de forcer ou d’obliger SketchUp a dessiner votre trait suivant
un des trois axes (rouge,vert ou bleu) grace aux fleches du clavier :

Appuyez une fois sur la fleche de gauche pour forcer a guider votre tracé sur I'axe vert,
Appuyez une fois sur la fleche du haut pour forcer a guider votre tracé sur I'axe bleu,
Appuyez une fois sur la fleche de droite pour forcer a guider votre tracé sur I'axe rouge,

Ré-appuyez une fois sur la fleche du clavier pour désacsupprimer pour la sélectionner

Déplacer un objet & I'aide d'une iINférence

Lorsque vous avez besoin de déplacer et positionner un objet par rapport a un autre, il ne faut pas
prendre I'objet (a déplacer) n'importe ou au hasard, servez-vous des inférences. Pour vous aider,
posez-vous toujours cette question : « Quel point (Cad quelle inférence) de mon objet a déplacer
doit correspondre au point (Cad I'inférence) sur lequel je dois le poser ? »

Vous pouvez a présent faire la manipulation suivante :
déplacer un objet a l'aide des inférences

Sélectionnez I'objet ou le tracé a déplacer en faisant un
double clic sur la surface pour un objet en 2D ou un triple clic
pour un objet en 3D,

prenez I'outil Déplacer ( Outil déplacer/copier ),

cliquez sur le point d’inférence de I'objet a déplacer, votre
objet suit votre souris,

rapprochez et placez le curseur sur le point d’inférence de
destination,

vérifiez que I'inférence est bien affichée puis cliquez pour valider le déplacement.
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Cc0020 INFERENCES AIDE AU DESSIN

Deéplacer les objets

Clic sur un objet simple ou triple clic pour sélectionner I'objet entier
Avec I'outil Déplacer cliquer sur I'objet et cliquez a nouveau sur 'emplacement souhaité

Qu'est ce que l'inférence de I'objet 2

L'inférence est un "point déterminant” : extrémité, milieu...
Sur 'image ci-contre, I'inférence "extrémité apparait en vert

Deplacer ovec les inférences

Triple Clic sur I'objet

Avec l'outil Déplacer, Cliquer sur un "point chaud” de I'objet
Ici,sur I'angle inférieur droit que nous voyons a I'écran, en-
suite,sans cliquer, déplacez vous sur I'axe qui détermine le
déplacement, cliquez et donnez une valeur

Deéplacer les objets

Clic sur un objet simple ou triple clic pour sélectionner I'objet
entier

Avec I'outil Déplacer cliquer sur I'objet et cliquez a nouveau
sur 'emplacement souhaité

Qu'est ce que l'inférence de I'objet

L'inférence est un "point déterminant” : extrémité, milieu...
Sur 'image ci-contre, I'inférence "extrémité apparait en vert

Deplacer ovec les inférences

Triple Clic sur I'objet

Avec l'outil Déplacer, Cliquer sur un "point chaud” de I'objet
Ici,sur I'angle inférieur droit que nous voyons a I'écran, en-
suite,sans cliquer, déplacez vous sur I'axe qui détermine le
déplacement, cliquez et donnez une valeur

Surl'axe rouge 2,00m
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Aildes au dessin
Dessinez une forme.

Nous voulons créer une ligne paralléle a la ligne AB
VOus cliquez sur le point de départ, puis vous survolez
I'aréte de référence AB, lorsque vous avez l'info bulle
Paralléle a I'aréte, cliquez Vi

Paralléle & |'aréte

| TVPE D'INFERENCE COULEUR POSITION
INFER E POMCTUELLE
Extrémité Vert Extrémltedur}e aréte ou d'un
demi-cercle
Point du milieu Bleu clair Milieu d'une aréte
Intersection Maoir Intersection d'une ligne
Sur la face Bleu fonce Surface d'une face
Sur I'aréte Rouge Sur le long d'une aréte
INFERENCE LINEAIRE
Wert
. Sur l'un des 3 axes de la zone
Sur |'axe Bleu .
de dessin
Rouge
Vert En se déplacant sans tracer
A partir du point Bleu d'aréte a partir d'un point
Rouge d'un objet
En se deplagant
Perpendiculaire et paralléle Ligne magenta perpendiculairement ou
parallélement & une aréte
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Cc0021 OPERATIONS BOOLEENNES

Méthode universelle
Les opérations booléenne (appelées aussi Pathfi nder en anglais) sont présentes dans tous les
logiciels de modélisation 3D, SketchUp en a6 :

union . soustraire m découper ‘ diviser © et enveloppe externe ‘ pour faciliter leur
utilisation, mais ceux-ci ne fonctionnent pas a tous les coups si vos
objets sont trop complexes ou s’il ne sont pas fermés.

Elle sont trés utiles pour créer des objets complexes a partir de
formes simples.

Voici donc la méthode utilisée avant que ces outils apparaissent et
qui fonctionnent a coup sar :

1- Prenons exemple avec 2 groupes, un cube et un cylindre, comme
ce sont 2 groupes, I'on peut encore facilement les désolidariser pour
les positionner,

2- Sélectionnez-les puis -
faites un clic droit et choisissez I'option Intersection des faces > Avec ~

la sélection,

3- une ligne apparait a I'intersection des 2 groupes, mais cette ligne
d’intersection est placé en dehors des groupes, il 'y donc pas encore -
d’interaction avec le cube et le cylindre,

4- il faut a présent éclater le groupe en faisant un clic droit sur celui-ci
puis choisir Eclater, faites de méme pour I'autre groupe,

5- vous pouvez a présent retirer les surfaces et arétes dont vous ne
voulez plus pour obtenir I'objet souhaité. Voici un des résultats pos-
sible

Union

L’outil Union ‘ permet d’unir deux objets (groupes ou composants) pour n’en faire plus qu’un.
Attention : cet outil peut ne pas fonctionner si vos objets sont trop complexes (composés d’un trop
grand nombre d’arétes ou de formes ouvertes), pour cela utilisez la méthode universelle.

2- cliquez sur I'icone Union .

1- Sélectionnez les deux objets a unir, et vos objets sont fusionnés en un
seul.

Une autre méthode (plus longue) consiste a ne rien sélectionner,

1- cliquez sur I'icone Union‘,
2- cliquez sur le 1er objet,

3- cliquez sur le 2eme objet,
4- vos objets sont fusionnés.

Intfersection

L’outil Intersection @ permet d’obtenir les parties communes de 2 objets (groupes ou compo-
sants).

Attention : cet outil peut ne pas fonctionner si vos objets sont trop complexes (composés d’un trop
grand nombre d’arétes ou de formes ouvertes), pour cela utilisez la méthode universelle.

1- Sélectionnez les deux objets a unir,

2- cliquez sur I'icone Intersection m pour obtenir le résultat de I'opération.
Une autre méthode (plus longue) consiste a ne rien sélectionner,

1- cliquez sur l'icone intersection m
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2- cliquez sur le 1er objet,

3- cliquez sur le 2eme objet,

4- vos objets sont fusionnés.

Ci contre le résultat de I'opération menée sur les mémes solides que précédem-
ment

Soustraoction

L’outil Soustraire m permet de retirer un objet du second, ces objets
doivent étre des groupes ou composants.

Attention : cet outil peut ne pas fonctionner si vos objets sont trop com-
plexes (composés d’un trop grand nombre d’arétes ou de formes ou-
vertes), pour cela utilisez la méthode universelle.

Voici comment procéder, I'ordre est important :

1- cliquez sur l'icone Soustraire m
2- cliquez sur le 1er objet a soustraire,
3- cliquez sur le 2eme objet,

4- le 1er objet a été soustrait du 1er.
Voici un exemple avec 2 objets (un cylindre et un cube) avant et aprés I'opération
booléenne, sur la seconde image on a soustrait le cube au cylindre et sur la 3eme
image on a soustrait le cylindre au cube

Découper

L’outil Découper fa permet de se servir d’'un objet pour couper le second. Le fonctionnement est

le méme que soustraire sauf qu’ici les objets servant a 'opération ne sont [
pas supprimeés. Les objets doivent étre des groupes ou composants.

Attention : cet outil peut ne pas fonctionner si vos objets sont trop com-

plexes (composés d’un trop grand nombre d’arétes ou de formes ou- i :

vertes), pour cela utilisez la méthode universelle.
Voici la méthode, I'ordre a une importance :

1- cliquez sur I'icone Découper ‘

2- cliquez sur le 1er objet (celui que I'on va retirer du second),

3- cliquez sur le 2eme objet (celui qui va rester),

4- vos objets sont fusionnés.

Voir 'exemple ci-contre aprés I'opération booléenne, sur la seconde
image on a découpé le cube dans le cylindre et sur la 3eme image on a
découpé le cylindre dans le cube.

(D (]

Diviser

L’outil Diviser © permet d’obtenir 3 objets a partir de 2 objets (les deux objets de base + un objet
résultant de la partie commune des deux premier). Les objets doivent étre des groupes ou compo-
sants.

Attention : cet outil peut ne pas fonctionner si vos objets sont trop complexes (composés d’un trop
grand nombre d’arétes ou de formes ouvertes), pour cela utilisez la méthode universelle.

2- cliquez sur 'icone Diviser 2
1- Sélectionnez les deux objets a unir,
3- vous obtenez 3 objets indépendants.

Une autre méthode (plus longue) consiste a ne rien sélectionner,
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1- cliquez sur I'icone Diviser (),

2- cliquez sur le 1er objet,

3- cliquez sur le 2eme objet,

4- vous obtenez 3 objets indépendants.
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Cc0022 DEPLACEMENTS ET COPIES

Deéplacement

Réalisez un volume 3 D comme ci contre : 1x1x1,2
Triple CLic pour sélectionner I'élément

Pressez sur la touche Déplacement Copie

<

Déplacez I'élément de 1 m

:.:

Copie simple

% + CTRL

Sélecionnez I'élément, Prenez I'outil déplacement ‘ﬁ’ pressez
simultanément sur CTRL
Utilisez l'inférence sur le point inférieur droit, tapez 1

Copie Multiple

Copie de I'élément : Sélection, Outil ‘ﬁ’ + Ctrl, Tapez 1 (1m)
puis immédiatement aprés avoir cliqué, tapez x5

Copie et distribution

Copie de I'élément (1) a 3 m (2) , puis immédiatement
aprés tapez /3

Les 3 éléments sont distribués équitablement sur 'axe
rouge entre le premier et le dernier
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Ouvrir un élément de la bibliotheque d’images (Menu Fichier, Banque d’'images)

Triple clic pour sélectionner un élément, et cliquer sur le pot de peinture {%

Matiéres ) e R e Wt | =
&

Sélecﬁonnerlédiﬁonl A

R ET T

I N N -
T
¢l $ mlc::uieurs j &

- .

Attention : s'’il s’agit d’'un groupe d’objet, tous les éléments du groupe seront teintés

CLiquez sur 'onglet EDITION

Couleur
. Matigres __ 8] =1 ¥ ¥ Matitres Y =
Option Couleur oo A0l [ |[Covewr D01 a
. ouleur_ =
Vous cliquez sur une couleur pro- Créer une matiére. S H 3
posée dans les échantillons pré- o4 | Maere1 N
sents ou bien pour composer une yA
couleur inexistante,cliquez surle ... L
,Cligq Sélectiogfier 1@' ﬁ . !
bouton é en haut a droite du <P > {aY |Covieurs | > i e
panneau
DOnnez un nom a votre couleur | -
Déplacez vous sur le cercle chromatique pour trouver votre teint |
[ Utiliser lmage de texture
o . | = |
Opacité , réglette gérant la transparence o [T % e
t [o,10m ) Y DE:LT;E?"SH la | i
Opacité
==
oK | Annuler | j $
——— -
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Importer une ftexture

Créer une matiére... ™ E

I pierre rouillée

Donnez lui un nom (B)

Cliquer sur le bouton Ouvrir (A) et allez chercher une image

(png,jpg,bmp...)

Il faudra essayer avant de régler I'echelle de la texture (C)

Mode de couleur

=1 |

Muandier: |Caolor Wheel

VI

v Utiliser limage de te

I pierreRouillee, JPG

=4

Au dessous de "Couleur”, vous avez une liste déroulante vous

proposant plusieurs modes, cliquez sur la fleche, choisir RVB

Couleur

Nuancer: S
< I [ ]

« - [
[

echelle de texture
Chargez la texture "Texture Bois”

Réalisez un plancher de 8m x 5m
Appliquez la texture, vous obtenez
ceci

L'echelle de la texture n’est pas
bonne, nous allons changer et mettre
2 dans la zone

0 10m } ' [~ Colorier
£ |~0,07m Réinitialiser |
[ sttt
|—|'-| [ =2
oK | Annuler | |
Couleur
Muander: | Color Wheel ;I
HLS
HSEB
RGE

vous pouvez entrer vos codes RGB

Matiéres
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Sélectionner  Edition |
Couleur

Nuander: ICoIor Wheel l. d

f

Texture

¥ Utilier lmage de texture

=]

| bois E
od

Al

2

o

| texture bois.jpg

W} I~ Colorier
¥

% [~0,0mm

Opacité
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bois

VOila pour notre texture

Sélectionner  Edition |

g
5
N
0_’
o

Si vous souhaitez le parquet Couleur
dans l'autre sens, il faut re- wense o e <[l of
tourner I'image (rotation 90°) r
avant d’enregistrer une copie r
Texture

v Utiliser limage de texture

I texture bois.jpg ﬁy .
E } I™ Colorier
(4]

Salect

<:I I-J|> Q ICouIeurs j @

r 1 | — .

I bois herizontal

Sélectionner  Edition |
Couleur

Muancier: ICoIor Wheel - I.

Reglage de tonalité

Pour avoir un parquet plus foncé, manipulez la réglette

v Utiliser lmage de texture
I texture boisVert.jpg i
| pegeea— —_—

Les emplacements de texture Sélectionner | éditon | 2
¢ D Y| v citue ~| B

Cliquez sur I'onglet Sélectionner = i
Vous obtenez la liste des genres de texture DE Coulevrs

Couleurs-Moms

Couverture
m Couvre_sol

Si vous cliquez sur 'icbne Maison vous avez les textures rela- E::uim

tives a votre projet uniquement R Modéles du ton

N Métal

ik L4 Persiennes
Pierre
Repére
Symboles de la matiére
Tapis et textiles
Translucide
Végétation

m

4
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c023

parametres ombres

-
Pour afficher toutes les options des ombres, cliquez sur 'icone B en haut a droite de la fenétre.
Rendez visible les ombres portées dans la scéne en cochant Affi-

cher les ombres ou en cliquant sur 'icone correspondante (Icone
] . , ) [v Afficher les ombres E
OU”[I| Afficher les or’nbres) dans Ia_ b,arrg d oqtlls. . Houre [ —
Réglez la date et I'heure pour obtenir I'orientation du soleil et des - -
.. , . L, . [ T -
ombres (pour une position géographique précise voyez les Para- Date ) £ yyams s as onp ® 1

E I :I‘
Claircir  m— 80

Eclaircir: permet d’agir sur I'éclairage des faces uniquement. D 4 =

[ Ukiliser le soleil pour les ombres

Foncer: agit sur l'intensité de couleur de 'ombre projettée et I'éclai- | affichage : W sur les Faces ¥ Sur le sal
rage des faces. [ A partir des arétes

Utiliser le soleil pour les ombres permet lorsqu’Afficher les ombres est décoché, d’utiliser la po-
sition du soleil pour obtenir des ombres progressives sur les faces en mode Ombré (Icdne outil

ombrel)

Choisissez de projetter les ombres sur les faces de la géométrie et/ou sur le sol

A partir des arétes permet de projetter 'ombre des arétes lorsque les faces sont transparentes
(pour info: Les objets opaques au dela de 70 % ne projettent plus d’'ombres portées). Paramétres
d’emplacement

Fenétre de géolocalisation pour le parometrage des
ombres

Les Parametres d’emplacement se trouve dans le menu Fenétre > Infos sur le modéle puis dans
le menu Emplacement.

Geéoréferencement

Le géoréférencement permet de lier les informations de Position géographique au modéle pour
une utilisation dans Google Earth, ainsi votre modéle exporté se placera directement sur la carte
du monde.

Position géographique

Infos sur le modéle

Le positionnement géographique est utilisé pour bl

y . . . : s Crédit iliser le géoréférencemen

Porientation du soleil et donc des ombres mais égale- | lomensor: WCoe e e

ment pour le géoréférencement. Fictier | POSON O8ographique

Choisissez le pays et la ville ou se situe votre scéne. | [tastiaues | k=

Pour définir précisément sa position vous pouvez s Epsen s &
. . . Latitude :  48.8670M

entrer sa longitude, sa lattitude et le fuseau horaire en o s

cliquant sur le bouton Définir un emplacement person- [Defii o emplacement persermalie... |

na | isé i l;lriental:ion du soleil

Ou est le Nord ? Orntation dunord : [ 0.0 | sélectionmer |

Une fois la position géographique définie, il vous faut B

orienter correctement votre modeéle en indiquant le

nord.Pour cela entrez une valeur en degrés dans le champ Orientation du nord ou cliquez sur le
bouton Sélectionner pour le placer manuellement dans la scéne : Cliquez dans votre scéne pour
placer le cercle muni d’'une croix, déplacez le curseur pour indiquer la direction du nord et cliquez
a nouveau pour valider.

Faites apparaitre la direction du nord par une ligne orangé dans votre scéne en cochant la fonc-
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C0024

Styles

Au menu Fenétre, cliquez pour obtenir le panneau Styles

STYLE ET EXPORT

Par défaut , c’est style simple qui est sélectionné, cliquez sur "Arétes de Croquis”

s

]
-

Votre projet est représenté comme un croquis a la main
POur paramétrer I'outil, cliquez sur Edition

Le premier icbne "Arétes” @

vous permet de paramétrer plus ou
moins de chevauchement des traits

perpendiculaires

Par défaut, comme ci contre il a

une valeur de 5

Si vous le passez a 10, vous obte-

nez le détail ci dessous

) & B B

T
tyles
7—— Aquarelle
T = Lignes de croquis au
| pinceau & aquarelle.
L

Sélectionner Iédiﬁon Mélang

o 7

A

-~

A}

8 .[

~—
r’. /:_l -

Sélectionner
Fl [N w

Q & 8E

| Aguarelle
Lignes de croquis au
pinceau a aguarelle.

sélectionner  Edition |Mélange|

BOOEE

¥ Arétes

[T arétes arrigrs
WV Profis V¥ Arétes prolo
[ Profondeur v Halo 5

Miveau de détails:

Aréte

fi

Trait:

Couleur: Toutes identiques ;I .
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La case "Profondeur”
Lorsque elle n’est pas cochée, (1)
Lorsque elle est cochée (2)

Niveau de détail

Niveau de détail bas Niveau détail haut

Miveau de détails:

Parametres de Face

Icbne | j

Nous avons changé la couleur Recto

Style

Radiographie

Style
200e® ©

Essayez les différents styles
Ci contre style : Affichage mode Ombré avec texture

Parametres d’arriere plan

Icbne D

Choisir les couleurs

« d’arriere plan

o duciel

o dusol

Afficher les filigrannes

Il suffit de charger une image

2/ 3

Aguarelle o
Lignes de croguis au @
pinceau & aquarelle,
o
Sélectionner  Edition | Mélange I
BOORQ Face
Couleur du recto .
Couleur du verso |:|
Style Radiographie

@0eee ©
¥ Activer la transparence

Qualité de transparence: IRapide 'l

sy |

I Aquarelle

Lignes de croquis au
pinceau a aguarelle,

Oﬁénﬁa

Sélectionner  Edition |Mélange|

DODG

Arriére-plan |:|
v Ciel D

V¥ sol |:| Transparence
o J_

[V Montrer le sol par en dessous

Arriere-plan
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Mélanges

Styles 9
Le panneau Mélange permet de visualiser les différents styles cumu- o~ || Aquarele
lés I ﬁ 1|| Lignes de croguis au

L U pinceau & aquarelle.
- i

Q%Pﬂ@

2 ; . Sélectionner | Editon  Mélange |
Vous sélectionnez un style visuel sur le bas de panneau et vous I'ap- || pour mélanger des paramétres du style actue

pliqueZ aux zones pIUS haut prélevezes dans le panneau du bas et

appliquez-es aux catégories souhaitées.

@ Paramétres d'aréte

'E] Paramétres de face

D Paramétres d'arriére-plan

Ea Paramétres de filigrane

Paramétres de modélisation

Sélectionner

¢l ¢ ml.ﬂ.rétes de croquis j @
7 — R
il nialinlEl
Lt Ll el

export ] -- I

Menu Fichier --> Exporter --> Graphique 2D

Vous permet d’exporter une image 2 D a partir de votre scéne
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co025

Créer un plan de section

Pour créer une section, cliquer sur 'outil Section '@

Accrochez vous a une inférence, pour créer la coupe
Afficher les plans de section @

Afficher les coupes @
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C0026 LES OUTILS D'HABILLAGE

outil metre

Cet ouitil ﬁ sert de 2 manieres différentes
Pour mesurer : accrochez vous a des points sur les contours de forme et cliquez , une fenétre en
bas a gauche de I'écran vous permet de visualiser ces mesures

D’autre part, lorsque vous positionnez 'outil sur une aréte existante, vous déplacez , I'outil vous
met en place un guide, tapez une valeur

Outil Cotation

?\ Cliquez sur les point d’accrochage pour faire afficher
les cotes

Outil Raporteur

@ Permet de mesurer les angles, positionner I'outil sur une aréte puis sur l'autre, la mesure s’af-
fiche en bas a gauche de I'écran

Outil Texte / Repere

Cliquez sur I'outil et sur le dessin, pour inserer du texte sous forme d’une
ligne repére

Déplacer l'origine ou le sens des axes

L'outil :&: permet de modifier 'emplacement de l'origine ainsi que le sens des 3 axes

Outil Texte

Pressez sur I'outil , une fenétre s’ouvre, vous entrez votre texte et vous lui donnez des attributs

Pewmen @
Saisir du texte

Police | Tahoma j INormaI ;I

Algnement [Gauche | Hauteur [0,25m

Forme [¥ Plein [V Extrudé |n,nan
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cooz7

L’outil Cotation permet de placer un repére visuel indiquant la distance entre deux points.

DISTANCE
La création d'une cotation se fait en trois étapes :

1- Prenez I'outil Cotation 2\

2- cliquez sur un point d’inférence,

3- glissez et placez le curseur sur le second point d’inférence,

4- cliquez pour valider ce second point d’inférence,

5- déplacez le curseur de la souris pour éloigner la cotation des points d’inférence sur lesquels
elle est accrocheée,

6- cliquez pour valider. Une méthode plus rapide pour coter une aréte consiste a cliquer sur I'aréte
et non pas ces points d’inférence, de glisser le curseur de la souris pour éloigner la cotation et de
cliquer pour valider. Si vous n’arrivez pas a la placer sur le bon plan, utilisez I'outil Orbite

Une cotation se place toujours suivant un plan en 2 dimensions, si vous ou le bouton du milieu
de la souris pour réorienter votre vue.

RAYON/DIAMETRE
Pour affi cher le diamétre d’un cercle :

1- Prenez I'outil Cotation %
2- cliquez sur le pourtour du cercle,

3- déplacez le curseur de la souris et tournez autour du cercle pour choi-
sir sa position fi nale, QD
4- cliquez pour valider. ~—DIA152,36cm

Pour affi cher le rayon d’'un arc de cercle :

1- Prenez I'outil Cotation %\
2- cliquez sur le pourtour de I'arc de cercle,
3- déplacez le curseur de la souris et tournez autour de I'arc de cercle pour trouver la position4

Pour intervertir la cotation diamétre en rayon :
1- Prenez 'outil Sélectionner 't,

2- faites un clic droit sur la cotation,
3- dans la fenétre flottante choisissez Type > Rayon.
Pour intervertir la cotation rayon en diamétre : :

7‘6,18cm:

1- Prenez l'outil Sélectionner R
2- faites un clic droit sur la cotation,
3- dans la fenétre fl ottante choisissez Type > Diamétre.

INFORMATIONS PERSONNALISEES

Une cotation révéle la valeur d’'une distance, d’'un rayon ou d’un diamétre, toutefois elle peut étre
modifi € manuellement pour la changer ou y ajouter du texte.

Attention : Modifier manuellement la valeur d’'une cotation ne modifiera pas la valeur de I'objet
coté. Reportez-vous aux Parametres de cotation avanceés ci-dessous pour étre averti de la non
concordance d’une cbte.Pour modifier une cotation :

1- Prenez 'outil Sélectionner h
2- faites un double clic sur la cotation,
3- entrez votre texte et/ou une nouvelle valeur,

4- validez avec la touche Entrée.
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Pour conserver la valeur réelle de la cotation suite a des modifi cations de taille sur I'objet placez

ces symboles <> a la place de la cbte.

SketchUp se chargera de remplacer les symboles <> par la valeur réelle.
Exemple : en entrant « cote minimale : 1247 mm », la cotation peut ne plus étre exacte si vous
modifi ez la taille de I'objet, par contre si vous entrez « céte minimale : <> » la cotation sera tou-

jours a jour et sans risque d’erreur.

Astuce : pour écrire sur plusieurs lignes comme sur I'image a droite, placez \n en fi n de chaque

ligne.
Exemple : cé6te\n minimale :\n <>

REGLAGE DES COTATIONS

Pour accéder aux réglages des cotations, utilisez le menu Fenétre > Infos sur le modéle et choi-

sissez I'onglet Dimensions.

Vous trouverez une partie consacré aux cota-
tions :

- Aligner les cotations sur I'écran, a pour eff et
d’affi cher les cotation toujours face a I'écran
quelque soit l'orientation de votre scéne.

- Aligner le long de la ligne de cotation ne tiens
plus compte de l'orientation pour s’aligner sur le
méme plan que la cotation (utile pour les vues
en 2 dimensions).

Vous avez alors la possibilité de placer la cbte
au dessus, au centre ou a I'extérieur de la ligne
de cotation.

- Vous remarquerez que les options ci dessus

Animation
Camposants
Credits

Dimensions
Ermplacement
Fichier
Rendu
Skatistiques
Texte

Unités

Texte

Tahoma : 12 Points Palices. .. .

Traits de légendes

Extremités : |Fleche fermée ﬂ
Cotation
f* Aligner sur 'écran

" Aligner sur la ligne de cakation

Sélectionner boutes les cobations |

Ackualiser les cokations sélectionnées |

Paramétres de cotation avancés |

n’ont pas modifi € 'apparence des cotations dans la scéne, simplement pour pouvoir utiliser les
deux systemes en méme temps, mais il est possible d’actualiser la scene :

- Enfoncez le bouton Sélectionner toutes les cotations si vous voulez sélectionnezles

avec l'outil Sélectionner toutes les sélectionner pour les actualiser, le cas échéant sélectionnez-
- Enfoncez le bouton Actualiser les cotations sélectionnées pour mettre

a jour toutes les cétes sélectionnées.
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Cc0028 MODELISER UN TERRAIN &N 3D

geolocalisation

o . .
Au menu Fichier, GeoPosition, Ajouter un emplace- ® #euerinempement | a i
ment IPUYQOUZD“ 81990 Recher Sélectionner une région I

Donnez une adresse sur un terrain en pente
Cliquer sur sélectionner une région, déterminez la
zone a récupérer puis sur Capter

= —
& Ajouter un e‘nl;:!ac?nt -l @
Annuler | Capter

_

E— T
JTFMAMJ JASOND o084 M 16:28

<4 ; 8 @‘ R Google Earth Snapsi[y
LA Erl=Reg=-1L I L L LD

T
Activer/désactiver le relief
Active et désactive I'affichage du relief.

Sur la barre d’outils Google, cliquer sur activer/De-
sactiver le relief
vous verrez maintenant votre relief

Sele
&

20 e@

» s@e2co senene

Dans la barre d’outils des vues, cliquez sur
vue de desssus

Réalisez un rectangle qui englobe le terrain

Mettez vous dans une vue qui vous permette
de voir le profil, déplacez votre rectangle de

maniére qu’il soit juste plus bas que la partie
la plus basse du terrain

Dans mon cas, j’ai a peu prés 7 m de dénivellé, je commence a copier mon rectangle sur I'axe
bleu a 8 m pour qu’il soit un peu au dessus du point le plus haut
puis je distribue 20 copies entre les deux copies :

Outil ‘5’ + Ctrl , donnez la valeur 8, puis immédiatement aprés, tapez 20x
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Selectionnez 'ensemble des rectangles avec le terrain toujours a I'intérieur
Puis Clic droit , Intersection des Lreer groupe
Faces, Avec le Modéle Intersection des faces ,

Avec le modéle

Ayec la sélection

Vous pourrez supprimer
'image du terrain et
garder seulement les
courbes

Dévérouillez (bouton
droit, dévérouiller) et
supprimer le terrain

Inverser les faces

Supprimez maintenant tous les rec-
tangles (rectangle de selection en
bordure) afin de garder le terrain ou
figurent maintenant les courbes de
niveau

Outilss Bac & Sable

oe o6

Ouvrez la barre d’outils Bac a sable
Selectionnez toutes les courbes et cliquez sur le 1er bouton (a partir des contours)
Vous pouvez déplacer le terrain et supprimer les courbes de niveau
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C0029 MODELER UN TERRAIN &N 3D

modeler le terrain

Ouvrez la barre d’outils Bac a sable
Selectionnez le terrain précédemment crée, puis clic droit, Eclater

Infos sur I'entité
Effacer
Masguer
Werrouiller

Muadifier le groupe

L'outil Modelage 0‘ Vous per-
met de creuser ou bomber votre
terrain a votre convenance

Cliquez votre valeur, qui s’affiche
en bas a gauche de votre écran
pour déterminer le rayon d’appli-
cation de la déformation

implanter un batiment

Réalisez un batiment et placez le sur le terrain mo-

delé (aidez vous des différentes vues)

1 2 Q0029 _sketchp modeker Tarrain3D

Pour réaliser le terrassement autour du batiment
Selectionnez le batiment, puis cliquer sur l'outil

Tamponner ﬁ et cliquez sur le terrain
Faites varier les fléches rouges en hauteur pour
niveller a votre convenance




Lreer groupe
Intersection des faces Avec le modéle

Inverser les faces Ayec la sélection

oe o6
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Cc0030 SKETCHUP : BIEN COMMENCER

CHOIX DU MODELE TYPE

Au lancement de SketchUp, I'écran de bienvenue apparait :

(si vous avez choisi de ne plus 'afficher au démarrage, vous pouvez la retrouver en utilisant le
menu Aide > Bienvenue dans SketchUp ...).

SketchUp vous demande de choisir un modeéle type, c’est a dire quel type de travail vous pré-
voyez de faire avec le logiciel (architecture, ingénierie, conception de produits et menuiserie, vue
en plan, etc) et pour chacun d’eux l'unité de mesure.

Cliquez sur le bouton correspondant en haut a droite de cette fenétre pour choisir un modeéle type

CHOISIR UN MODELE TYPE

Le choix du modéle a peu d’'importance, il se charge simplement de choisir 'orientation de la vue,
les couleurs de sol et de ciel et le type de trait, par contre le choix de I'unité de mesure est impor-
tant.

Choisissez un modele qui utilise les unités en Métres ou Millimétres. Dans tous les cas il sera pos-
sible de modifier tous les aspects de ce modéle plus tard et tout au long du travail (voir plus bas
Unités de mesures).

Si vous désirez que SketchUp s’ouvre toujours avec ce modéle type, vous pouvez cocher 'option
en bas a gauche pour ne plus afficher cette fenétre au démarrage.

Il ne vous reste plus qu’a enfoncer le bouton Commencer a utiliser SketchUp.

MODE DE PROJECTION

Votre document ouvert, il va falloir choisir le type de projection, paralléle ou perspective depuis le
menu Cameéra.

Sachez que par défaut sketchup utilise une projection perspective, il est préférable de choisir une
projection paralléle pour créer vos objets dans SketchUp.

Projection paralléele

La projection paralléle appelée aussi perspective axonomeétrique ou perspective cavaliére est sur-
tout utilisée dans un but technique ou architectural, plus simple a réaliser a la main ou par infor-
matique, elle permet de donner une impression de relief tout en conservant les proportions dans
une direction donnée.

c’est donc cette méthode que I'on privilégiera pour construire nos objets dans SketchUp.

Perspective

La perspective donne une image de la réalité, elle correspond a
'image de la vision humaine.

Pour comprendre comment représenter un dessin en perspective,

il suffit de placer une ligne d’horizon puis un point de fuite sur cette
ligne.

A partir de ces 2 éléments, tous les traits donnant de la profondeur a
un objet vont converger vers ce point de fuite et donner cette perspec-
tive.

Ainsi les objets éloignés deviendront de plus en plus petit et 'espace-
ment (identique) entre chaque objet paraitra plus étroit.

On privilégiera donc cette représentation en perspective pour pre-
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senter un projet final, lors d’une intégration d’'un batiment dans une photographie ou d’une visite
virtuelle, pour le reste notamment lors de la conception on préférera une projection parallele.

MODIFIER L’UNITE DE MESURES

Vous avez choisi un modeéle type avec une unité de me-

sures (le Métre par exemple), il se peut qu’au cours de Animation Unités de longusur _
votre projet ou lors de la création d’'un nouveau document — cetens s e
cette unité ne vous convienne plus. e s ¥ Activer Fancrage de longueur; |0, 1mm
Pour accéder a ces informations, passez par le menu Fe- e Syl e
nétre > Info sur le modéle, une fenétre apparait : s uninés anglaires

unités o

dans le menu de gauche choisissez Unités,

il ne vous reste plus qu’a modifier 'unité de mesures,
privilégiez une Précision a deux chiffres apres la virgule,
puis désactivez ’Ancrage de longueur qui peut géner lors
de la construction.
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C0030

Cliquez sur l'icone Google Earth &F R

File Edt View Camera Draw Tooks  Window Help
[ —— - + = - = = L T
X | [ o ocation AR X 1k D 2| &

Select Region | |

INurth America Search [

Géolocalisation choisir une locali-
sation

Conseil : Pour obtenir une quali-
té d’image optimale, effectuez un
zoom avant le plus rapproché pos-
sible. Affichez a I'écran I'espace
dont vous avez besoin pour créer

votre modéle, mais pas davantage.. | || G E
Remarque : Vous n'utiliserez I'ins-

tantané en noir en blanc de Google o

Earth que pour positionner avec —_ : ' D |
précision votre modéle. Il ne sera

pas réexporté vers Google Earth ik

avec le reste de votre modeéle.

La latitude et la longitude indiquées dans la boite de dialogue ”Infos sur le modéle” de SketchUp
sont toujours calculées par rapport au centre de la vue Google Earth. Ainsi, le fait de déplacer les
axes n‘aura aucun impact sur la latitude et la longitude de votre modéle.

Dans SketchUp, créez un modéle par dessus l'instantané Google Earth.

Vous pouvez également :

« importer I'instantané Google Earth dans un fichier SketchUp contenant un modéle existant.
Dans ce cas, utilisez les outils "Déplacer”, "Faire pivoter” et "Mettre a I'’échelle” pour positionner
avec précision votre modeéle existant sur l'instantané Google Earth.

« placer un modeéle provenant d’un fichier SketchUp distinct dans le fichier contenant l'instantané
Google Earth.Dans SketchUp, sélectionnez Ouitils » Google Earth » Activer/Désactiver le relief
pour visualiser la version 3D de votre instantané Google Earth. Si le relief de votre instantané
n’est pas plat, il apparait sous la forme d’une surface inclinée en 3D, qui refléte le relief 3D

dans Google Earth.

Activer/Désactiver le relief ou cliquez sur le bouton du méme nom.

Dans SketchUp, utilisez I'outil de déplacement pour ajuster la position verticale de votre modéle
par rapport a I'instantané Google Earth 3D. Votre modéle ne doit pas flotter au-dessus du relief, ni
étre trop affaissé dans le sol.

Conseil : Pour "verrouiller” 'outil de déplacement afin de ne permettre que les déplacements dans
la direction verticale (axe bleu), appuyez sur la touche "fleche vers le haut” ou "fleche vers le bas”
de votre clavier.

Si un élément que vous tentez de déplacer sur I'axe bleu ne se déplace pas dans cette direction,
cet élément est probablement collé. Pour le décoller, cliquez dessus avec le bouton droit de la
souris et sélectionnez "Décoller”.

Remarque : Si vous ne réussissez pas a positionner votre modele sur l'instantané Google Ear-
th sans qu'’il flotte au-dessus du sol, ni ne soit trop affaissé dans ce dernier, vous pouvez ajouter

de la matiere au bas du modeéle. Dans Google Earth, le relief n’est pas parfaitement exact. Par
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conséquent, vous devez apporter quelques rectifications aux modeéles dans SketchUp afin qu’ils
s’affichent correctement dans Google Earth.

Dans SketchUp, sélectionnez Outils » Google Earth » Placer le modéle pour exporter votre modele
dans Google Earth. Google Earth devient alors votre application active et votre modéle s’affiche
sur le relief a 'emplacement que vous avez indiqué en utilisant I'instantané Google Earth.

Lo il T - e i} O b~ Bt
- e AT o

LI o r] R A ———————
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E0003 LES OUTILS De MODIFICATION

DEPLACEMENT

Dessiner une ligne avec I'outil crayon L déplacez la ligne avec I'outil déplacement é’
COoOPIE

Pour copier la ligne c’est le méme outil Déplacement ‘c‘ associé a la touche CTRL

ROTATION
J'ai déssiné un rectangle, puis avec I'outil Rotation ™ | cliquer sur une
extrémité, puis sur 'autre ,et entrez un angle

ECHELLE

Sélectionnez un rectangle, avec 'outil Echelle i | cliquez et entrez le coeffi-
cient
de réduction (inférieur a 1) ou d’augmentation (sup a 1)

EXTRUSION

L'outil Tirer / Pousser * permet d’extruder des faces (ou surfaces)
Cliquer avec l'outil sur le rectangle, puis tirer vers le haut, et entrez une
valeur

Dessinez a I'aide de I'outil Crayon des lignes comme ci

contre, avec I'outil ‘ , tirer vers le haut, un volume

se creée, les arétes entre le rectangle et les nouvelles

lignes empéchent le rectangle de s’extruder

Avec les mémes lignes de base, tirer vers le bas, dans ce cas, c'est la
face supérieure seule qui est amenée vers le bas
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Annulez vos opérations, revenez aux sur-
faces, et supprimez avec la gomme (séléc-
tion, et touche SUPPR) les arétes entre les
lignes brisées et le rectangle

L’extrusion se fait maintenant sur la forme
compléte

L’extrusion vers le bas se fait maintenant sur
le volume

OuTIL SUIVEZ MOl
Tracez d’abord un cercle (sur le plan XY) avec une ligne sur I'axe bleu (2)

‘

Avec l'outil Suivez moi e cliquez a la base de la surface crée, et suivre le contour du cercle

=N

Tracez un arc fermez avec une ligne

OuTiL DECALER

Tracez une forme fermée, avec I'outil Décaler :”5 , cliquer
sur le contour de la forme et amenez la souris d’un c6té
extérieur ou du coté intérieur pour décaler le contour
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c0022

CREER UNE ETOILE

avec l'outil cercle, dessinez un polygone de 5
cotés et de rayon 3

~ Dessinez ensuite des lignes pour faire une étoile
comme ci contre

Avec L’OUTIL GOMME @ cliquez sur
toutes les arétes inutiles

OuTiL DEPLACER

Avec l'outil deplacer E Déplacez une pointe de
I'étoile

Vous pouvez déplacer
seulement une zone vous
la déterminez par une
aréte, puis vous déplacez
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OuTiL DECALER

Avec l'outil décaler cliquer sur une aréte
et donnez une valeur

OuTiL POUSSER TIRER

Cliquer sur la zone a tirer, étirez vers le haut

OuTIL METRE

- CLiquer sur I'outil meétre déplacez

\\

1
e 1
o \
1 0
= o et
T ‘8 | Surla ligne
\-x | : 1 \‘-'\-\
N R Y
et | P
L i .
g I

Cela permet d’avoir des guides pour dessiner

o

Dessinez un rectangle dans 'emplacement des guides, puis avec
- I'outil Pousser Tirer, évider la zone
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cooos

ANNULER UNE ACTION

A tout moment il est possible d’annuler une action, mais il vous faudra faire la distinction entre une
action en cours (donc non achevée) avec un outil ou une action déja validée :
Annuler une action en cours

Cela signifie que vous avec commenceé un travail avec un outil (qui requiére plusieurs étapes) et
qui n'est pas achevé car vous n’étes qu’a une étape intermédiaire.

Ce peut étre le cas avec l'outil Ligne ( Outil ligne ) qui aprés avoir traceé un trait vous propose de
continuer ce tracé en donnant I'impression d’'un chewing-gum dont on n’arrive pas a se débarras-
ser ! (mais c’est son comportement normal puisque I'outil attends que vous fermiez le tracé pour
libérer I'outil).

Si avec l'outil Ligne vous vouliez simplement tracer une ligne et non pas fermer une forme, vous
pouvez annuler I'action en cours en appuyant une fois sur la touche ESC (Echap), rassurez-vous il
ne va pas annuler ce que vous avez déja fait, mais va simplement libérer I'outil.

Annuler une action déja validée

Si par contre vous avez réalisé un tracé et que celui-ci ne
vous convient pas, vous pouvez annuler votre action vali-
dée via le menu Edition > Annuler, vous reviendrez ainsi a
I'étape précédente.

Vous pouvez revenir autant de fois que vous voulez en
arriere via ce menu Edition > Annuler. Et si vous seriez allé
trop loin en arriére, vous pouvez toujours revenir en avant
via le menu Edition > Rétablir pour faire réapparaitre les actions annulés.

Notez qu’a droite de chaque fonction du menu vous trouverez souvent le raccourci clavier qui peut
vous faire gagner du temps. Ici Cmd+Z (sur Mac) ou Ctrl+Z (sur Pc) correspond a Edition > Annu-
ler.

menu edition > annuler

Je vous conseille de mémoriser ce raccourci car il est le méme dans la plupart des logiciels.

PLACER DES GUIDES DE CONSTRUCTION

Lorsque I'on dessine, on prépare souvent notre travail en placant des repéeres qui vont servir a
guider nos traces futurs.
Sketchup nous offre un outil Métre ( outil métre ) qui permet de faire

.
cecl : Rt

Prenez I'outil Métre ( outil metre ),

Lorsque vous approchez le curseur sur un des axes de couleur

(rouge, vert ou bleu) une petite pastille rouge en forme de carré vous assure que vous prenez bien
cet axe comme modele,prendre un axe comme base de votre ligne de guidecliquez pour valider
ce choix,

éloignez votre curseur dans la direction ou vous voulez placer une ligne de guide parallele a cet
axe,définir la ligne de guide tapez la distance désirée avec les touches numériques du clavier puis
enfoncez la touche Entrée pour valider cette distance,vous obtenez une ligne de guide en pointil-
lee.

Faites de méme avec un autre axe,ue autre ligne de guide
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vous avez a présent des lignes de construction qui vont faciliter vos futurs tracés.

Vous pouvez vous servir de ces lignes de guide pour en tracer d’autres, vous n’étes pas obligé de
reprendre sur les axes de couleurs. Créer une ligne de guide depuis une autre ligne de guide
Si vous désirez supprimer une ligne de guide :

Prenez I'outil Sélectionner ( outil sélectionner ),
cliquez sur la ligne de guide a supprimer pour la sélect

! N O S e
i e
|‘9+ i E'QJ, :
Axe vert | 482,0mm ' :9
i E oot
0 : | 662,7mm
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Cc0033 ROTATION DES OBJETS 3D

Ouvrir un élément de la bibliothéque d'images
(Menu Fichier, Banque d’images)
Ici nous avons importé une baie vitrée

Nous désirons la placer sur le cbté B, elle n’est
pas dans la bonne position

Si vous survolez votre baie, vous voyez deux pe-
tites croix rouges, le signe rotation s’affiche &

Faites tourner votre baie et tapez 90

Ces poignées rouges apparaissent sur tous les cotés
du composant
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C0035 OUTILS : OUVRIR LE GRAND JeEU

Pour afficher cette barre d’outils flottante, il suffit de passer par le menu Affichage > Palette (r....t,a
> Grand jeu d’outils. Elle regroupe les outils les plus utilisés et sont classés par catégories : |

« Les outils de base, H ./
« Les outils de dessin, ®c
« Les outils de modification, 5
» Les outils de construction, I
« Les outils de caméra, e o
. et les outils de visite. oe

)

Les outils de sketchUp ne se limitent pas a la simple barre d’outils, il en existe bien d’autres ol e
vous aurez besoin d’utiliser ponctuellement suivant votre travail. Vous allez pouvoir organise { j!
barre d'outils horizontale sous le menu : 4

sur PC :Menu Affichage > Palette d’outils puis cochez le type d’outil a afficher ou décochez-| *”?

le retirer. =
Sur Mac :Menu Affichage > Personnaliser la barre d’outils, une fenétre affiche pour chaque (r-rE-“
une icone et leur nom associés. -

: . . . , . . &
Pour supprimer des outils existant dans la barre il suffit de cliquer dessus et de les glisser er
hors de la barre, a I'inverse pour placer un outil, cliquez dessus et glissez-la dans la barre sous le
menu.

PERSONNALISER LA BARRE D’0OU-

TILS E= =
Je vous conseille de placer les outils Vues standard et Se s
Styles qui sont utiles a tous projets, pour le reste ce sera - £ 2 = 2
en fonction de vos besoins. Notez que ces outils sont tous L 2 = - -
accessibles via le menu principal (menu Caméra > Vues :;; i 8y "j:“_ '_'_;"1“_‘
- -

standard, Menu Affichage > Styles de face, etc), la barre
d’outils vous permet d’aller plus vite, pensez donc a prendre
le réflexe pour optimiser votre travail.

.I-Iﬂ
i
|
!
i
|
i
!
}
{
}
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C0035 OUTILS : OUVRIR LE GRAND JeEU

Pour afficher cette barre d’outils flottante, il suffit de passer par le menu Affichage > Palette (r....t,a
> Grand jeu d’outils. Elle regroupe les outils les plus utilisés et sont classés par catégories : |

« Les outils de base, H ./
« Les outils de dessin, ®c
« Les outils de modification, 5
» Les outils de construction, I
« Les outils de caméra, e o
. et les outils de visite. oe

)

Les outils de sketchUp ne se limitent pas a la simple barre d’outils, il en existe bien d’autres ol e
vous aurez besoin d’utiliser ponctuellement suivant votre travail. Vous allez pouvoir organise { j!
barre d'outils horizontale sous le menu : 4

sur PC :Menu Affichage > Palette d’outils puis cochez le type d’outil a afficher ou décochez-| *”?

le retirer. =
Sur Mac :Menu Affichage > Personnaliser la barre d’outils, une fenétre affiche pour chaque (r-rE-“
une icone et leur nom associés. -

: . . . , . . &
Pour supprimer des outils existant dans la barre il suffit de cliquer dessus et de les glisser er
hors de la barre, a I'inverse pour placer un outil, cliquez dessus et glissez-la dans la barre sous le
menu.

PERSONNALISER LA BARRE D’0OU-

TILS E= =
Je vous conseille de placer les outils Vues standard et Se s
Styles qui sont utiles a tous projets, pour le reste ce sera - £ 2 = 2
en fonction de vos besoins. Notez que ces outils sont tous L 2 = - -
accessibles via le menu principal (menu Caméra > Vues :;; i 8y "j:“_ '_'_;"1“_‘
- -

standard, Menu Affichage > Styles de face, etc), la barre
d’outils vous permet d’aller plus vite, pensez donc a prendre
le réflexe pour optimiser votre travail.

.I-Iﬂ
i
|
!
i
|
i
!
}
{
}
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C0030

L’approche de construction en 3D s’apparente a la construction d’'une maquette, on crée les
pieces détachées une par une puis on les assemblent et les emboitent pour aboutir a la construc-
tion finale.

UTILITE DES GROUPES

Groupe {1 dans le modele) E

Les inférences sont une aide précieuse a la construction car Calque : [Calque =]
les objets s’aimantent, mais dés que I'on approche deux piéces
les une des autres et que l'on valide I'inférence, les arétes ou
sommets en contact se collent définitivement et nos piéces n’en
forment plus qu’une seule. | Cachée ¥ Projeter des ombres
Il nest plus possible de retrouver nos deux piéces distinctes (a || Yerroullés v Recevoir des ombres
moins d’'un CTRL + Z (Pc) ou POMME + Z (Mac)).

Nu:um:l

Pour préserver I'indépendance de chaque piéce et pouvoir modifier la construction a volonté, nous
créerons un groupe pour chacune d’elles.

CREER UN GROUPE

Renommer un groupe dans la fenétre Infos sur I'entité

Sélectionnez les entités (arétes et surfaces) (Outil Sélectionner) a mettre dans le groupe,
faites un clic sur la sélection ou via le menu Edition et choisissez Créer un groupe,
Affichez la fenétre Infos sur I'entité depuis le menu Fenétre,

nommez votre groupe dans le champ Nom.

A présent un seul clic permet de sélectionner votre groupe pour le manipuler, une boite englo-
bante bleu vous indique visuellement que votre sélection est un groupe qui renferme des entitées.

MODIFIER LA GEOMETRIE D’UN GROUPE

Boite englobante d’un groupe

Faites un double-clic sur le groupe pour entrer a l'intérieur de
celui-ci et modifier indépendamment les différentes entitées.
Une boite englobante en pointillé apparait autour de votre objet
indiquant que vous pouvez sélectionner et manipuler les enti-
tées du groupe.

Les entitées en dehors de ce groupe sont grisées et ne sont
temporairement plus accessible.

Pour sortir du groupe, cliquez dans un espace vide de votre vue
3D.

ECLATER UN GROUPE

Pour supprimer un groupe et libérer les entitées de celui-ci :

Sélectionnez-le (Outil Sélectionner),

faites un clic sur la sélection ou via le menu Edition > Groupe et choisissez Eclater.

Pensez a éclater vos groupes a I'écart de toute géométrie pour éviter que les sommets et arétes
en contact ne se soudent et ne forment plus qu’un.

STRUCTURE ET HIERARCHIE DES GROUPES

Une fois vos groupes réalisés et nommés, vous allez commencer a les assembler, les emboiter
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les uns aux autres pour en faire un ensemble.
Jusqu’a présent ces groupes sont tous indépendant, pour faciliter leurs sélection et leurs déplace-
ment il devient intéressant de les grouper en suivant un lien de parenté.

Nous prendrons exemple d’une corbeille contenant plusieurs fruits le tout posé sur une table.
Affichez la structure des groupes de votre scéne via le menu Fenétre > Structure.

Les fruits, la corbeille et la table sont tous au méme niveau, si vous voulez tout déplacer, il vous
faudra tout sélectionner.

= strur.tut I struq‘.ture : .E.n.-ﬂ.c'!ure

Fitre ;| By ||| Foee ;| B W Fire: | B lFre : | B
[E] Sans titre [E] Sans titre | [E) Samns titre & Sans titre

m Corbedls m Corbede |- m Corbeile = m Tabla

m Oranges = m Fruks = m Fruits = m Corbeile

m Pommes m Oranges m Cwanges = m Fruks

m Raksing m Pommes m Pomemes m Oranges

m Tabds m Ralsing m Ralsing m Fomines

m Table m Tabés m Faising

Nous allons donner un lien de parenté (une hiérarchie) a ces groupes pour n’avoir qu’a déplacer la
table, la corbeille et les fruits suivront :

Parenter des groupes depuis la fenétre Structure

Commencgons par regrouper les fruits, sélectionnez-les (Outil Sélectionner) puis faites un clic droit
et choisissez Créer un groupe que vous nommerez Fruits dans la fenétre Infos sur I'entité,

pour lier les fruits a la corbeille, dans la fenétre Structure cliquez et glissez Fruits sur la Corbeille,
pour lier la corbeille a la table, dans la fenétre Structure cliquez et glissez Corbeille sur la Table.

A présent si vous cliquez sur un fruit, la corbeille ou la table, c’est toujours le parent qui est sélec-
tionné (dans notre exemple la table).

Si vous désirez bouger 'emplacement de la corbeille sur la table, cliquez sur Corbeille dans la
fenétre Structure et déplacez la.

2/ 2 C0040_sketchup_groupes



Cc0080 VISIO DONNEES DE FORME

Un dessin Microsoft Office Visio peut étre bien plus qu’'une image ; il peut aussi vous permettre
d’organiser vos données et de les exporter dans un rapport.
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C0940

OUTIL POSITIONNER LA CAMERA

L’outil Positionner la caméra permet d’avoir un point de vue du spectateur de la scéne en plagant
la caméra a hauteur des yeux dans le modéle.

Attention : cet outil n’est utilisable qu’en vue perspective, pour 'activer, rendez-vous dans le menu
Cameéra et cochez Perspective.

POSITIONNER A HAUTEUR DES YEUX

1- Orientez votre vue en 3D de maniéere a rendre accessible le positionnement de la caméra,

2- prenez I'outil Positionner la caméra (),

3- cliquez sur une surface ou dans I'espace de maniére a y placer manuellement la caméra,

4- I'outil et le curseur ont changés, vous étes passé a I'outil Pivoter (),

5- la caméra c’est placée automatiquement a la hauteur de 1,68m du point ou vous avez cliqué,
pour modifi er cette hauteur (que I'on appelle hauteur des yeux), entrez la nouvelle hauteur dans
la fenétre Mesures.

POSITIONNER ET CIBLER LE POINT DE VUE

A la diff érence du positionnement a hauteur des yeux, la caméra (et onc le point de vue) se trouve
a I'endroit exact ou vous cliquez et vous permet d’indiquer I'entité vers laquelle la caméra pointera.
1- Orientez votre vue en 3D de maniere a rendre accessible le positionnement

de la caméra,

2- prenez I'outil Positionner la caméra (),

3- cliquez et maintenez enfoncé le bouton gauche de la souris sur une surface ou dans 'espace
de maniére a y placer la caméra,

4- déplacez le curseur tout en maintenant enfoncé le bouton de la souris et pointez-le sur I'entité
vers laquelle la caméra doit pointer,

5- une ligne pointillée lie ces deux points, relachez le bouton gauche de la souris pour valider,

6- I'outil et le curseur ont changés, vous étes passé a I'outil Pivoter (),

7- la caméra c’est placée sur le premier point cliqué et pointe vers le second.

Attention, pour les verticales, allez au menu Caméra --> Perspective a deux points

OuUTIL PIVOTER

L’outil Pivoter ( ) permet d’orienter la vue comme un spectateur fi gé en complément de I'outil Po-
sitionner la caméra (sur place qui ne bougerait que la téte pour voir autour de lui. Il est utilisé).
Attention : cet outil n’est utilisable qu’en vue perspective, pour 'activer, rendez-vous dans le menu
Cameéra et cochez Perspective.

PIVOTER

1- Prenez l'outil Pivoter (),

2- cliquez et maintenez enfoncé le bouton gauche de la souris dans la vue,

3- déplacez le curseur autour de I'endroit cliqué pour orienter la vue de maniére comme si vous
tourniez la téte pour voir ce qui vous entoure, 4- relachez pour valider la nouvelle orientation.
HAUTEUR DES YEUX

1- Prenez l'outil Pivoter (),

2- dans la fenétre Mesures entrez au clavier la hauteur des yeux, le point de départ étant défi nit
par I'outil Positionner la caméra (),

3- enfoncez la touche Entrée pour valider.

OUTIL VISITE

L’outil Visite (') permet de se déplacer dans le modéle en marchant Positionner la caméra (ou en
courant. Il est utilisé en complément de I'outil ) et I'outil Pivoter ().

Attention : cet outil n’est utilisable qu’en vue perspective, pour 'activer, rendez-vous dans le menu
Cameéra et cochez Perspective.
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E0030

Menu Fichier, Banque d’'images 3D

Je tape le mot clé "door” , je choisis un modele

Il faut faire pivoter le modéle sur un plan vertical

Avec l'outil Rotation, Déplacez jusqu’a ce que vous obte-
niez le raporteur ROuge car nous devons faire pivoter sur
I'axe rouge

Lorsque celui ci s’affiche en rouge, prenez deux points sur la
largeur inférieure de la porte et faites pivoter lorsque s’af-

fiche I'info bulle "sur I'axe bleu _.I Exrémité dans le aroupe

= _—

Matiéres =
[Métal_ader_texturé bla 3
: @.
b

Couleur

I\l.landa':IColorwheeI vl.d i

Texture

W Utiliser l'mage de texture
|Me13|_stee|_Termred_White.j F &

<->|~0r15m } ™ Colorier
[H]

t [~0,15m .Réi'iﬁaiserl.a
couleur

MODIFIER L’ASPECT

Double clic surle composant, a I'aide de I'Ouitil
Pot de Peinture

Choix de la couleur et de la nuance

Choix de la texture

Opacité

[ | 0 =
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MISE A L’ECHELLE

Cliquer sur 'outil Echelle K

Cliquer sur une des poignées, et mettez un facteur d’echelle =—————- |
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C0030

Les composants se comportent comme des groupes pour ce qui est de la modification de ceux-

ci : une fois créé il faut entrer dans le composant pour le modifier. La création d’'un composant

est analogue a la création d’'un groupe. Vous sélectionnez ce que vous souhaitez voir devenir un
composant (triple clic avec I'outil sélection) et vous faites un clic droit sur votre sélection et vous
choisissez « créer un composant ». Vous pouvez aussi utiliser le raccourci clavier « G » ou l'icébne
qui se trouve a droite de I'outil sélection. A partir de 1a, vous devriez avoir une fenétre qui s’ouvre
et qui vous demande plusieurs informations.

Général

Nom: | tablette

Sélectionnez vos éléments, clic droit,Créer un com-
posant

Description:

Alignement

Lisison:  |Aucune v | Définir les axes du composant

™ Décnuper ouverturs
™ Toujours faire face & la caméra

I Ombires Face au soleil

Type! | ;]

¥ Remplacer Ia sélection par le composant

e
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Cc0050 DESSINER AVEC SKETCHUP

LES PREMIERS TRACES

Travailler dans un espace 3D n’est pas aisé pour un débutant, tout simplement parce que votre
écran est en 2D et que l'interprétation pour le cerveau en 3D (sur un écran 2D) est plus difficile.
Voila pourquoi je vous conseille de toujours commencer un travail en 2D méme pour les plus ex-
périmentes.

Pour cela il faut préparer votre scéne :

Vérifiez dans le menu Caméra que I'option Projection paralleéle soit cochée, si ce n’est pas le cas,
faites-le,

ensuite, utilisez une des Vues standard qui sont des icones vous permettant d’afficher des vues
en 2D (vue de face, vue de dessus, vue de droite, etc) que vous pouvez ajouter dans la barre
d’outils sous le menu (voir : Personnaliser la barre d’outils).

Vous voila en 2D, a présent prenez I'outil Ligne ( Outil ligne ), cliquez pour placer le premier point,
éloignez la souris et cliquez pour placer le second point,
une aréte se dessine, I'outil attends que vous placiez un
troisieme point, puis un quatriéeme, etc. Revenez sur le
premier point puis cliquez pour fermer la forme, une sur-
face se crée alors a l'intérieur de ces traits. Vous venez de
dessiner vos premiers traits pour obtenir une forme.

tracer plusieurs lignes pour obtenir une forme fermée 4
L'outil Rectangle ( icone de I'outil rectangle ) vous per-
met d’aller plus vite en dessinant une surface a 4 cotés :
cliquez pour placer le premier angle de votre rectangle,
éloignez la souris puis cliquez pour placer I'angle oppose.
tracer un rectangle

Attention, n’utilisez pas I'outil Orbite ( Outil orbite ), vous quitteriez alors I'espace 2D pour I'espace
3D, si toutefois cela avait été le cas, il vous suffit de cliquer a nouveau sur la Vue standard que
vous aviez choisi.

ANNULER UNE ACTION

A tout moment il est possible d’annuler une action, mais il vous faudra faire la distinction entre une
action en cours (donc non achevée) avec un outil ou une action déja validée :
Annuler une action en cours

Cela signifie que vous avec commencé un travail avec un outil (qui re- N R —E

quiére plusieurs étapes) et qui n'est pas achevé car vous n’étes qu’a

une étape intermédiaire.

Ce peut étre le cas avec l'outil Ligne ( Outil ligne ) qui apres avoir tra-

cé un trait vous propose de continuer ce tracé en donnant I'impression d’un chewing-gum dont on
n’arrive pas a se débarrasser ! (mais c’est son comportement normal puisque I'outil attends que
vous fermiez le tracé pour libérer I'outil).

Si avec l'outil Ligne vous vouliez simplement tracer une ligne et non pas fermer une forme, vous
pouvez annuler 'action en cours en appuyant une fois sur la touche ESC (Echap), rassurez-vous il
ne va pas annuler ce que vous avez déja fait, mais va simplement libérer I'outil.
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Annuler une action déja validée

Si par contre vous avez réalisé un tracé et que celui-ci ne vous convient pas, vous pouvez annuler
votre action validée via le menu Edition > Annuler, vous reviendrez ainsi a I'étape précédente.

Vous pouvez revenir autant de fois que vous voulez en arriére via ce menu Edition > Annuler. Et

si vous seriez allé trop loin en arriére, vous pouvez toujours revenir en avant via le menu Edition >
Rétablir pour faire réapparaitre les actions annulés.

Notez qu’a droite de chaque fonction du menu vous trouverez souvent le raccourci clavier qui peut
vous faire gagner du temps. Ici Cmd+Z (sur Mac) ou Ctrl+Z (sur Pc) correspond a Edition > Annu-
ler.

menu edition > annuler

Je vous conseille de mémoriser ce raccourci car il est le méme dans la plupart des logiciels.

PLACER DES GUIDES DE CONSTRUCTION

Lorsque I'on dessine, on prépare souvent notre travail en placant des repéres qui vont servir a
guider nos tracés futurs.
Sketchup nous offre un outil Métre ( outil métre ) qui permet de faire ceci :

Prenez I'outil Métre ( outil métre ),

Lorsque vous approchez le curseur sur un des axes de couleur (rouge, vert ou bleu) une pe-

tite pastille rouge en forme de carré vous assure que vous prenez bien cet axe comme mo-
dele,prendre un axe comme base de votre ligne de guidecliquez pour valider ce choix,

éloignez votre curseur dans la direction ou vous voulez placer une ligne de guide parallele a cet
axe,définir la ligne de guide tapez la distance désirée avec les touches numériques du clavier puis
enfoncez la touche Entrée pour valider cette distance,vous obtenez une ligne de guide en pointil-
lée.

Faites de méme avec un autre axe,ue autre ligne de guide

vous avez a présent des lignes de construction qui vont faciliter vos futurs tracés.

Vous pouvez vous servir de ces lignes de guide pour en tracer d’autres, vous n’étes pas obligé de
reprendre sur les axes de couleurs. Créer une ligne de guide depuis une autre ligne de guide

Si vous désirez supprimer une : : ;
ligne de guide : T P :r

: )
Pre.ne% I oqtll Sélectionner ( .9+ L 9+ |
outil sélectionner ), Axe vert| {482.0mm| : 9
cliquez sur la ligne de guide a i 5 p—
supprimer pour la sélect . : :
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Co04s

IMPORT D’UNE IMAGE

b4 Fichier JHa L
Menu Fichier --> Importer --> Fichier , cocher I'option 142 Fichier 1°G SR
Utiliser comme image 135 Fichier PG r4| |
33 Fichier JPG * Utiliser comme image
1:30 Fichier JPG " Utiliser comme texture
44 Fichier PG r‘ &:ﬂg S nouvelle
21 Fichier JPG @

Avec l'outil Métre "’@ mesurez la longueur totale de la
maison sur le plan, dans notre cas, cela fait 6.13 m
alors qu’elle fait réellement 13.75 m

Nous faisons la division 13.75/6.13 pour trouver
notre coefficient : 2.24

ECHELLE

Clic sur I'image, outil Echelle K
Cliquez sur une poignée, étirez, cliquez et tapez 2.24

Vous pouvez maintenant dessiner sur le plan
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Cc0090 MODELER UN TERRAIN &N 3D

MODELER LE TERRAIN

Ouvrez la barre d’outils Bac a sable

Selectionnez le terrain précédemment crée, puis clic droit, Eclater Infos sur I'entité
Effacer
Masguer
Verrouiller

Muadifier le groupe

L'outil Modelage 0‘ Vous per-
met de creuser ou bomber votre
terrain a votre convenance

Cliquez votre valeur, qui s’affiche
en bas a gauche de votre écran
pour déterminer le rayon d’appli-
cation de la déformation

IMPLANTER UN BATIMENT

Réalisez un batiment et placez le sur le terrain mo-

delé (aidez vous des différentes vues)

1 2 Q0046 sketchup modeker Terrain3D

Pour réaliser le terrassement autour du batiment
Selectionnez le batiment, puis cliquer sur l'outil

Tamponner ﬁ et cliquez sur le terrain
Faites varier les fléches rouges en hauteur pour
niveller a votre convenance




Lreer groupe
Intersection des faces Avec le modéle

Inverser les faces Ayec la sélection

oe o6
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Cc0090 MODELISER UN TERRAIN &N 3D

GEOLOCALISATION

. . " . @ Ajouter un emplacement - g1
Au menu Fichier, GeoPosition, Ajouter un emplace- Rl _ =
ment IPUYQOUZD“ 81990 Recher Sélectionner une région I

Donnez une adresse sur un terrain en pente
Cliquer sur sélectionner une région, déterminez la
zone a récupérer puis sur Capter

= —
& Ajouter un e‘nl;:!ac?nt -l @
Annuler | Capter

_

E— T
JTFMAMJ JASOND o084 M 16:28

<4 ; 8 @‘ R Google Earth Snapsi[y
LA Erl=Reg=-1L I L L LD

T
Activer/désactiver le relief
Active et désactive I'affichage du relief.

Sur la barre d’outils Google, cliquer sur activer/De-
sactiver le relief
vous verrez maintenant votre relief

Sele
&

20 e[

» s@e2co senene

Dans la barre d’outils des vues, cliquez sur
vue de desssus

Réalisez un rectangle qui englobe le terrain

Mettez vous dans une vue qui vous permette
de voir le profil, déplacez votre rectangle de
maniére qu’il soit juste plus bas que la partie
la plus basse du terrain

Dans mon cas, j'ai a peu prés 7 m de dénivellé, je commence a copier mon rectangle sur I'axe
bleu a 8 m pour gu’il soit un peu au dessus du point le plus haut
puis je distribue 20 copies entre les deux copies :

Outil ‘5’ + Ctrl , donnez la valeur 8, puis immédiatement apreés, tapez 20x
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Selectionnez 'ensemble des rectangles avec le terrain toujours a I'intérieur
Puis Clic droit , Intersection des Lreer groupe
Faces, Avec le Modéle Intersection des faces ,

Avec le modéle

Ayec la sélection

Inverser les faces

Vous pourrez supprimer
'image du terrain et
garder seulement les
courbes

Dévérouillez (bouton
droit, dévérouiller) et
supprimer le terrain

Supprimez maintenant tous les rec-
tangles (rectangle de selection en
bordure) afin de garder le terrain ou
figurent maintenant les courbes de
niveau

OuTILS BAC A SABLE

oe o6

Ouvrez la barre d’outils Bac a sable
Selectionnez toutes les courbes et cliquez sur le 1er bouton (a partir des contours)
Vous pouvez déplacer le terrain et supprimer les courbes de niveau
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Ouvrir un élément de la bibliotheque d’images (Menu Fichier, Banque d’'images)

Triple clic pour sélectionner un élément, et cliquer sur le pot de peinture {%

Matiéres ) e R e Wt | =
&

Sélecﬁonnerlédiﬁonl A

R ET T

I N N -
T
¢l $ mlc::uieurs j &

- .

Attention : s'’il s’agit d’'un groupe d’objet, tous les éléments du groupe seront teintés

CLiquez sur 'onglet EDITION

COULEUR
Matigres __ 8] =1 ¥ ¥ Matitres Y =
Option Couleur P —r l | [Corierr po1 a
. - Créer une matiére... o E a
Vous cliquez sur une couleur pro- o = 4
posée dans les échantillons pré- 1z
sents ou bien pour composer une s
couleur inexistante,cliquez surle  sélectio Er’ . . -
@ . . Couleurs - MNuandier: ICoIor Wheel ;I I
bouton en haut a droite du ¢ @ d — 0
panneau / E]
DOnnez un nom a votre couleur |
Déplacez vous sur le cercle chromatique pour trouver votre teint i |
| = |
Opacité , réglette gérant la transparence « [o.10m % g I colorier
t [o,10m ] Y DE:LT;E?"SH la | i
Opacité
| [100=]
OK | Annuler | j $
Jj (4
T w T M=
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IMPORTER UNE TEXTURE Créerune matiere.. =]

I pierre rouillée

Donnez lui un nom (B) A

Cliquer sur le bouton Ouvrir (A) et allez chercher une image
(png.jpg,bmp...)

Muancier: | Color Wheel LID -

v Utiliser limage de te

Il faudra essayer avant de régler I'echelle de la texture (C)

=4

I pierreRouillee, JPG

0 10m } ' [~ Colorier
% [~0,0mm DRﬂnmahser la

couleur

| | [r =
oK | Annuler | |
MODE DE COULEUR
Au dessous de "Couleur”, vous avez une liste déroulante vous Couleur
proposant plusieurs modes, cliquez sur la fleche, choisir RVB . p—— B
HLS
HsE
RGE
Couleur
Nuam:ier:lj vous pouvez entrer vos codes RGB

= N [
o I I [ =]

Matigres =]
ECHELLE DE TEXTURE [bos a
o4
Chargez la texture "Texture Bois” M Al
Sélectionner  Edition | V’

Reéalisez un plancher de 8m x 5m S
p Nuander:lm.d i.

Appliquez la texture, vous obtenez

ceci r

I

Texture
L'echelle de la texture n’est pas ¥ Utliserfmage de texture
bonne, nous allons changer et mettre || [texurebosn o @
2 dans la zone [0,10m } ™ Colorier
$ [~ o Sinitialiser la
e
Opacité
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bois

VOila pour notre texture

Sélectionner  Edition |

g
5
N
0_’
o

Si vous souhaitez le parquet Couleur
dans l'autre sens, il faut re- wense o e <[l of
tourner I'image (rotation 90°) r
avant d’enregistrer une copie r
Texture
v Utiliser limage de texture
Ihexture bois.jpg ﬁy .

& |2n } I~ Colorier
&

Salect

<:I I-J|> Q ICouIeurs j @

r 1 | — .

I bois herizontal

Sélectionner  Edition |
Couleur

Muancier: ICoIor Wheel - I.

REGLAGE DE TONALITE

Pour avoir un parquet plus foncé, manipulez la réglette

v Utiliser lmage de texture

I texture boisVert.jpg i
| peee— —_—
Sélectionner |Ediﬁon| 2
LES EMPLACEMENTS DE TEXTURE
¢ D Y| v citue ~| B
. : e v -
Cliquez sur I'onglet Sélectionner < Couleurs
Vous obtenez la liste des genres de texture Couleurs Hloms
Couverture
Couvre_sol
m Eau il
Si vous cliquez sur I'icdbne Maison vous avez les textures rela- —— e o
tives a votre projet uniquement i Métal
adib bl Persiennes A
Pierre 3
Repére
Symboles de la matiére
Tapis et textiles
Translucde L
Végétation -
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Cc0050 LES INFERENCES DANS SKETCHUP

Une inférence est un « repére » placé sur différents points de votre construction que SketchUp va
reconnaitre et mémoriser, elles vous permettront de vous « accrocher » aux points, arétes, sur-
faces, au milieu d’'une aréte et méme de pouvoir dessiner des perpendiculaires ou paralléles sans
aucun repeére de construction.

Votre travail sera plus facile, plus rapide et précis, c’est donc un allié de choix que vous devrez
maitriser.

Pour découvrir ce qu’est une inférence, prenez 'outil ligne ( outil ligne ) par exemple puis placez
le curseur de la souris a l'origine des 3 axes (rouge, vert et bleu) sans cliquer, vous remarquerez
que votre curseur s’aimante sur ce point et vous le signale par une pastille jaune et I'inscription
Origine. Si maintenant vous cliquez, vous étes assuré de démarrer votre trait a I'origine des axes.
C’est aussi simple que cela !

Attention, les inférences ne peuvent pas étre désactivés, nous verrons comment les contourner
lorsqu’elles nous génent.

REPRESENTATION ET COULEURS DES INFERENCES

Il existe plus d’une dizaine d’inférence différentes, c’est pourquoi elles sont regroupés par catégo-
ries :

Inférences de point

Afin de découvrir ces inférences de point, dessinez une forme a 4 cotés avec I'outil ligne ( outil
ligne ) et en joignant le dernier point au premier de fagon a fermer cette forme et faire apparaitre
une surface :

- Nous avons vu la premiére qui est I'inférence d’origine des axes symbolisée par une pastille
jaune :

Inférence de I'origine des axes

- Chaque point de votre tracé devient une inférence

fj extremlt(? r’econnallssas)le a sa pastille verte : R
inference a I'extremite d’'une arete - | Origine
- Les arétes sont également des inférences dés l'instant
ou vous placez le curseur dessus et que vous vous déplacez le long de cette

aréte vous verrez apparaitre un rectangle rouge : v i
inférence d’'une arete

- Les arétes proposent en plus une inférence en leur milieu que vous trou-

verez sous forme d’une pastille bleu ciel (a vous de la retrouver car elle n’est pas symbolisée sur
laréte) :

inference du mileu d’'une arete

- Les inférences de surface s’affichent avec un losange bleu foncé dés I'instant ou votre curseur
est placé sur une surface (nous verrons leur utilité plus tard)

inference d'une surface V4
- Les lignes de guide possédent une inférence a chaque Paraiidie A Maréts
croisement celles-ci matérialisées par une croix rouge :

inférence a l'intersection de 2 lignes de guide

Inférences de ligne

Les inférences de ligne vont vous permettre de dessiner
des lignes ou des formes primitives parallelement ou per-
pendiculairement a une ligne déja existante et tout cela
sans avoir a tracer une ligne de construction.
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Lorsque que vous tracez une forme vous remarquerez que votre tracé prends suivant son orienta-
tion la couleur d’'un axe (rouge, vert ou bleu), cela vous assure que le trait sera paralléle a cet axe
inférence paralléle a I'axe rougeinférence paralléle a I'axe vertinférence paralléle a I'axe bleu
Parfois vous aurez besoin de tracer une paralléle a une aréte (une ligne) qui n’est pas paralléle a
un des axes. Pour cela :

Placez le premier point de votre tracé,

puis venez poser le curseur de votre souris sur une arete donc vous voulez qu’elle soit paralléle
sans cliquer,

vous obtenez une inférence d’aréte, cela signifie que

SkectchUp garde en mémoire la direction de cette aréte,

déplacez le curseur de la souris dans un axe paralléle a

cette aréte pour que SketchUp vous propose une inférence

de ligne paralléle reconnaissable a sa couleur rose,

cliquez pour placer le second point et tracer votre ligne,

celle-ci est maintenant paralléle. s

dessiner une paralléle a une aréte grace aux inférences =~

Faites de méme si vous désirez obtenir une perpendicu- B At
laire a une aréte déja construite, il vous faudra a I'étape 4

trouver la perpendiculaire. ~

dessiner une perpendiculaire a une aréte grace aux infé-

rences

INFERENCES DE FORME

i Square
Les inférence de forme sont des inférences qui vous signale que vous
dessinez un carré (ou un rectangle d’or) lorsque vous utilisez I'outil Rec-
tangle ( icone de I'outil rectangle ) :

inférence pour trouver un carré avec l'outil rectangle

Elles se manifestent également lorsque vous dessinez un demi-cercle

avec l'outil Arc de cercle ( Outil_arc) : A
Inférence pour obtenir un demi-cercle avec 'outil arc .

Il en existe aussi pour trouver la tangeante a un arc de cercle, mais bela
nous verrons cela plus tard.

INFERENCES DE GROUPE ET COMPOSANTS

Nous verrons un peu plus tard ce qu’est un groupe et un composant, pour I'instant imaginez-le
comme une brique de Lego avec ses arétes et surfaces que vous pouvez manipuler et déplacer.

Sur cette brique de Lego vous allez retrouver toutes les infé-

rences de point (extrémité, aréte, point du milieu, etc) et les infé-

rences de ligne (paralléle et perpendiculaire), simplement pour

reconnaitre visuellement que c’est un groupe ou un composant 7

les pastilles seront toutes de couleur mauve avec l'information « Bxtrémité dans e groupe
dans le groupe » ou « dans le composant » : .
inférence avec une extrémité d’'un groupe
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UTILISER PLUSIEURS INFERENCES EN MEME TEMPS

SketchUp garde en mémoire les inférences que vous ciblez, il est méme capable d’en mémoriser
plusieurs et de différents types. Pour garder en mémoire une
inférence il faut rester une petite seconde sur celle-ci, lorsque
vous voyez l'info-bulle (« extrémité » par exemple), vous étes
sur qu’elle est en mémoire.
Mémorisez votre premiére inférence,allez chercher une autre AL
inférence en plagant le curseur de la souris dessus (sans
cliquer) et patientez une seconde jusqu’a voir l'info-bulle,
votre seconde inférence est mémorisée, des axes pointillées
vous guident pour pouvoir les suivre,

vous pouvez essayer de connecter les deux inférences me-
morisées pour commencer votre prochain tracé.

Tout cela sans aucune ligne ou repére de construction qui
pourrait surcharger visuellement votre scéne.

A partir du point

FORCER UNE INFERENCE

Lorsque vous aurez beaucoup de dessiner des tracés a I'écran, il sera de moins en moins aisé
d’obtenir une inférence de ligne (perpendiculaire ou parallele) car lorsque vous déplacerez votre
curseur, celui-ci risque de s’accrocher a toutes les inférences qu’il trouvera sur son chemin, et
malheureusement les inférences ne sont pas désactivables sur SketchUp.

Toutefois il existe une solution, c’est de forcer ou d’obliger SketchUp a dessiner votre trait suivant
un des trois axes (rouge,vert ou bleu) grace aux fleches du clavier :

Appuyez une fois sur la fleche de gauche pour forcer a guider votre tracé sur I'axe vert,
Appuyez une fois sur la fleche du haut pour forcer a guider votre tracé sur I'axe bleu,
Appuyez une fois sur la fleche de droite pour forcer a guider votre tracé sur I'axe rouge,

Ré-appuyez une fois sur la fleche du clavier pour désacsupprimer pour la sélectionner

DEPLACER UN OBJET A L’AIDE D’UNE INFERENCE

Lorsque vous avez besoin de déplacer et positionner un objet par rapport a un autre, il ne faut pas
prendre I'objet (a déplacer) n'importe ou au hasard, servez-vous des inférences. Pour vous aider,

posez-vous toujours cette question : « Quel point (Cad quelle
inférence) de mon objet a déplacer doit correspondre au point
(Cad l'inférence) sur lequel je dois le poser ? »

Vous pouvez a présent faire la manipulation suivante :
déplacer un objet a I'aide des inférences

Sélectionnez I'objet ou le tracé a déplacer en faisant un
double clic sur la surface pour un objet en 2D ou un triple clic
pour un objet en 3D,

prenez I'outil Déplacer ( Outil déplacer/copier ),

cliquez sur le point d’inférence de I'objet a déplacer, votre objet suit votre souris,
rapprochez et placez le curseur sur le point d’inférence de destination,

vérifiez que l'inférence est bien affichée puis cliquez pour valider le déplacement.
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C0090

STYLES

Au menu Fenétre, cliquez pour obtenir le panneau Styles

STYLE ET EXPORT

Par défaut , c’est style simple qui est sélectionné, cliquez sur "Arétes de Croquis”

s

]
-

Votre projet est représenté comme un croquis a la main
POur paramétrer I'outil, cliquez sur Edition

Le premier icdne "Arétes” @

vous permet de paramétrer plus ou
moins de chevauchement des traits

perpendiculaires

Par défaut, comme ci contre il a

une valeur de 5

Si vous le passez a 10, vous obte-

nez le détail ci dessous

) & B B

T
tyles
7—— Aquarelle
T = Lignes de croquis au
| pinceau & aquarelle.
L

Sélectionner Iédiﬁon Mélang

o 7

A

-~

A}

8 .[

~—
r’. /:_l -

Sélectionner
Fl [N w

Q & 8E

| Aguarelle
Lignes de croquis au
pinceau a aguarelle.

sélectionner  Edition |Mélange|

BOOEE

¥ Arétes

[T arétes arrigrs
WV Profis V¥ Arétes prolo
[ Profondeur v Halo 5

Miveau de détails:

Aréte

fi

Trait:

Couleur: Toutes identiques ;I .
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La case "Profondeur”
Lorsque elle n’est pas cochée, (1)
Lorsque elle est cochée (2)

Niveau de détail

Niveau de détail bas Niveau détail haut

Miveau de détails:

Parametres de Face

Icbne | j

Nous avons changé la couleur Recto

Style

Radiographie

Style
200e® ©

Essayez les différents styles
Ci contre style : Affichage mode Ombré avec texture

Parametres d’arriere plan

Icbne D

Choisir les couleurs

« d’arriere plan

o duciel

o dusol

Afficher les filigrannes

Il suffit de charger une image
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Aguarelle o
Lignes de croguis au @
pinceau & aquarelle,
o
Sélectionner  Edition | Mélange I
BOORQ Face
Couleur du recto .
Couleur du verso |:|
Style Radiographie

@0eee ©
¥ Activer la transparence

Qualité de transparence: IRapide 'l

sy |

I Aquarelle

Lignes de croquis au
pinceau a aguarelle,

Oﬁénﬁa

Sélectionner  Edition |Mélange|

DODG

Arriére-plan |:|
v Ciel D

V¥ sol |:| Transparence
o J_

[V Montrer le sol par en dessous

Arriere-plan
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Mélanges

Styles 9
Le panneau Mélange permet de visualiser les différents styles cumu- o~ || Aquarele
lés I ﬁ 1|| Lignes de croguis au

L U pinceau & aquarelle.
- i

Q%Pﬂ@

2 ; . Sélectionner | Editon  Mélange |
Vous sélectionnez un style visuel sur le bas de panneau et vous I'ap- || pour mélanger des paramétres du style actue

pliqueZ aux zones pIUS haut prélevezes dans le panneau du bas et

appliquez-es aux catégories souhaitées.

@ Paramétres d'aréte

'E] Paramétres de face

D Paramétres d'arriére-plan

Ea Paramétres de filigrane

Paramétres de modélisation

Sélectionner

¢l ¢ ml.ﬂ.rétes de croquis j @
7 — R
il nialinlEl
Lt Ll el

EXPORT - -- -

Menu Fichier --> Exporter --> Graphique 2D

Vous permet d’exporter une image 2 D a partir de votre scéne
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Cliquez sur l'icone Google Earth &F R

File Edt View Camera Draw Tooks  Window Help
[ —— - + = - = = L T
X | [ o ocation AR X 1k D 2| &

Select Region | |

INurth America Search [

Géolocalisation choisir une locali-
sation

Conseil : Pour obtenir une quali-
té d’image optimale, effectuez un
zoom avant le plus rapproché pos-
sible. Affichez a I'écran I'espace
dont vous avez besoin pour créer

votre modéle, mais pas davantage.. | || G E
Remarque : Vous n'utiliserez I'ins-

tantané en noir en blanc de Google o

Earth que pour positionner avec —_ : ' D |
précision votre modéle. Il ne sera

pas réexporté vers Google Earth ik

avec le reste de votre modeéle.

La latitude et la longitude indiquées dans la boite de dialogue ”Infos sur le modéle” de SketchUp
sont toujours calculées par rapport au centre de la vue Google Earth. Ainsi, le fait de déplacer les
axes n‘aura aucun impact sur la latitude et la longitude de votre modéle.

Dans SketchUp, créez un modéle par dessus l'instantané Google Earth.

Vous pouvez également :

« importer I'instantané Google Earth dans un fichier SketchUp contenant un modéle existant.
Dans ce cas, utilisez les outils "Déplacer”, "Faire pivoter” et "Mettre a I'’échelle” pour positionner
avec précision votre modeéle existant sur l'instantané Google Earth.

« placer un modeéle provenant d’un fichier SketchUp distinct dans le fichier contenant l'instantané
Google Earth.Dans SketchUp, sélectionnez Ouitils » Google Earth » Activer/Désactiver le relief
pour visualiser la version 3D de votre instantané Google Earth. Si le relief de votre instantané
n’est pas plat, il apparait sous la forme d’une surface inclinée en 3D, qui refléte le relief 3D

dans Google Earth.

Activer/Désactiver le relief ou cliquez sur le bouton du méme nom.

Dans SketchUp, utilisez I'outil de déplacement pour ajuster la position verticale de votre modéle
par rapport a I'instantané Google Earth 3D. Votre modéle ne doit pas flotter au-dessus du relief, ni
étre trop affaissé dans le sol.

Conseil : Pour "verrouiller” 'outil de déplacement afin de ne permettre que les déplacements dans
la direction verticale (axe bleu), appuyez sur la touche "fleche vers le haut” ou "fleche vers le bas”
de votre clavier.

Si un élément que vous tentez de déplacer sur I'axe bleu ne se déplace pas dans cette direction,
cet élément est probablement collé. Pour le décoller, cliquez dessus avec le bouton droit de la
souris et sélectionnez "Décoller”.

Remarque : Si vous ne réussissez pas a positionner votre modele sur l'instantané Google Ear-
th sans qu'’il flotte au-dessus du sol, ni ne soit trop affaissé dans ce dernier, vous pouvez ajouter

de la matiere au bas du modeéle. Dans Google Earth, le relief n’est pas parfaitement exact. Par
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conséquent, vous devez apporter quelques rectifications aux modeéles dans SketchUp afin qu’ils
s’affichent correctement dans Google Earth.

Dans SketchUp, sélectionnez Outils » Google Earth » Placer le modéle pour exporter votre modele
dans Google Earth. Google Earth devient alors votre application active et votre modéle s’affiche
sur le relief a 'emplacement que vous avez indiqué en utilisant I'instantané Google Earth.

Lo il T - e i} O b~ Bt
- e AT o

LI o r] R A ———————
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C0910

Préparation dans sketchup

Dans sketchup, ajustez la vue que vous désirez récupé-

LAYOUT

rer dans Layout

Vous pouvez également créer une scéne par vue
Enregister le dessin (obligatoire)

Au menu Fichier --> ENvoyer a Layout

Layout s’ouvre automatiquement et vous demande de
choisir un format

Behiar Modfer Affcher Tmts Dnpowr Duiin Digm Faain Aide

x]z-r-m-@-@amEr~grrpBERS,

<Eans fitves - Fage i

Faas ghomar b i Pichmhe o i pivctor Sntrmes e v s U [T

wex pous

Mise en page dessins multiples

[t s | 1 5|
[ — 1 2
Tosis, e 1

o (EIE Bl

[T ———
et - I =

(sl - =E

1 Page =

Une page a été crée

Pour créer une
autre page, aller a
'onglet Page

- Cliquer sur Dupli-

quer

—— 5 o ]

[+&)[-]

1 Pq Dupliquer la page sélectionnéel

Sur la page 2, nous aimerions 2 vues présentées vertica-
lement

Cliquer sur le dessin, a l'aide des grosses poignées
bleues, rétrécissez le cadre a moitié

Puis avec Déplacer + Ctrl, copiez le dessin sur la droite,
vous obtenez 2 fenétres avec la meme vue.

Changer lo vue dans une fenetre

2T 1A

Double clic dans la fenétre, avec I'outil Orbite, modifiez la vue

Ou : Clic droit --> Scéne, choisissez une scene que vous avez préalablement enregistrée sur

Sketchup
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Ajuster la vue

Avec I'outil Orbite, double clic dans la fenétre, clic droit, Zoom

étendu

Clic sur le dessin, clic droit, vous avez également les vues

standards

Vue avec une forme

Réalisez un cercle avec I'outil cercle au dessus d’'une vue

Selectionnez le cercle et la fenétre
contenant la vue, clic droit --> Créez

un masque de découpage

Création d’une forme libre

Avec I'outil Crayon créez la forme
que vous désirez et procédez comme
précédemment pour effectuer le dé-

coupage

Pour disposer plusieurs fenétres
qui se superposent, cliquer sur une

Copier
Suppiimer

Placer surlecolgue achuel [ Pt
Dhsposer | Places desant

Comtier . Faive gaane
Rntourmar " Fairs mcuinr
Bankirir | Placer duniaen

—_—

sur Layout

Créer un rectangle
Panneau Style de Forme

Remplissage : cliquer sur le bouton Rem-
plissage puis sur une couleur du panneau

de Couleurs

Faire les réglages nécessaires

Motif

fat Dessin au trait noir =
Damier blanc

++ K<

Farrlas anlidas meir Farmlas

Style de rtexte
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Créer des
formes

Cliquer sur Motif et

choisissez le motif sou-
B B naie

Couper
Copier

Supprimer

Disposer
Aligner
Centrer

Retourner

Grouper

Mostifier s wuse 30
s aved Boenchlip

Pette & jiar e sfdrence du madde
Perpective:

Y smndad

Plee

Sciman,

Caupar
Capm
SappIiTe

Plycer sur be calques aciued
Depiier .
Ceniret 0
Rettsiines

Dnmisvun de Swichiie smgivnes

Omizien I

hhurrars du soanad

Eclalar cope lang

s du somal

Al

Placer sur le calque actuel

Créerun masque de géénupage

s fenétre,
’E Clic droit, disposition --> placer devant, ou arriére...

|Plateau par detaut 2

v Coulews X
[ l\

[Roue | RVE [T5v [Grs [ image [ Lste |

Rouge

—— )

Wert

)

IHEL‘I 1 1 ——
[N | 23
E:bac‘té 1 | I —
[ CoEm e ST [ 100

255
255

|

E,ﬁ

[ Mot dutrait |

o) —s
Tirets: - ‘;
Sye: o=

Fléche début: -~ 2pts -
Fléche fin: ~ Zpts -
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C0911

Préparation dans sketchup

Au menu Fenetre, cliquer pour afficher le panneau Styles

Choisir un style, bouton droit, Enregistrer Sous

Enregistrer votre style dans un répertoire
Ouvrez Style Builder et ouvrez le style enregistré

Faire les modifications de traits et de couleur
Enregistrez le style

STYLE BUILDER

e e o %
Craiesur tableaunoir gy
Lignes de croquis & la @ | @ @
craie sur arriére-plan
ol | aris fonce, s

Sélectionner Iédmon I Mélange I

¢l $ m I.Aretes de croguis l 9

Supprimer

Cra Enregistrer sous

Ajouter au modéle

S Py rl’rﬂ_ !
I |

(S| L e I -

Ouvrez Sketchup , Ouvrez I'explorateur Windows, cherchez votre style, faites glisser dans le pan-

neau

@b‘| J b Drdlnateur » DATA {D‘]I ¥ Mes documents » formation

Styles P 2 » 9
ICraynn ﬁ
Ugrjes au crayon a @
main leveée, = H G
el |
Sélectionner ||§diﬁm ! Mélangel & Favoris
dﬂ ¢ m IAretes de croquis J f% B Bureau
& Téléchargements
27 A1 |2 2
(1T ‘| =] T |_|
i P | L | B | R

—
. —
&
= [——
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B Ouwrir =

T -
=] Emplacements récer

- Bibliothéques
D Documents

Partager avec = Courrier électronigt

Mom

|#| Enregistrernentfuto_plan0004.skp
|| mib_style3.style
|#| plan0004.skp
|| plan0004.skb
[#]| mfb_stylel .style
Ia],rﬂl Ia],rout
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